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1. Overview 

This document provides information relevant to those using the Parker Vehicle System 

Gateway (PVSG). 

 

 Note: this document is subject to change. Contact Parker for more information 

should you have questions not covered by this document. 

1.1. Product Overview 
The following diagram shows an overview of the software components and communication 

interfaces currently supported by the PVSG. 
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Internally, the PVSG consists of three basic components: 

• Router: provides CAN and J1708 interface including all functionality related to CAN 

message filtering performed to allow CAN messages received on one CAN port to be 

transmitted on one or more of the other CAN ports. 

• Server: provides on board management capabilities including USB / Ethernet / Wireless 

interface and all functionality associated with them. 

• Power Control: performs power management functions including controlling when the 

product goes to sleep and wakes up. 

1.2. Connector Pinout 
The pinout for PVSG connectors are as follows: 

J1 Connector 

Pin Function Pin Function 

J1-1 GPIO2 J1-11 CAN3 Shield 

J1-2 GPIO1 J1-12 CAN3 High 

J1-3 CAN2 Shield J1-13 CAN3 Low 

J1-4 CAN2 Low J1-14 CAN4 Shield 

J1-5 CAN2 High J1-15 CAN4 High 

J1-6 CAN1 Shield J1-16 CAN4 Low 

J1-7 CAN1 Low J1-17 CAN5 Shield 

J1-8 CAN1 High J1-18 CAN5 High 

J1-9 Ground J1-19 CAN5 Low 

J1-10 Power J1-20 Ground 

Note: GPIO1 and GPIO2 are configurable wakeup sources (active high, see "Power 
Management" section below). 

Note: CAN1, CAN2, CAN3, CAN4, CAN5 are configurable wakeup sources (see "Power 
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Management" section below). 

Note: Power (J1-10) requires greater than 8V to wakeup and more than 6V to continue 
operating. 

J2 Connector 

Pin Function Pin Function 

J2-1 J1708A J2-9 RS232 RTS 

J2-2 J1708B J2-10 Ground 

J2-3 Ground J2-11 LIN4 

J2-4 LIN2 J2-12 Recovery 

J2-5 Ground J2-13 RS232 RX 

J2-6 LIN1 J2-14 RS232 TX 

J2-7 RS232 CTS J2-15 Ground 

J2-8 Output 1 J2-16 LIN3 

Note: All RS232 signals are labelled as DTE (Data Terminal Equipment) signals (TX & RTS 
are outputs and RX & CTS are inputs). 

Note: Access to RS232 signals should be restricted to only those authorized to use them (e.g. 
place PVSG inside a locked compartment, don't include RS232 connection in production 
harness). 

Note: Access to the Recovery input (J2-12) should be restricted to only those authorized to 
use it (e.g. place PVSG inside a locked compartment, don't include recovery connection in 
production harness). 

Note: Output 1 may appear to toggle due to the strobing of the open load detection circuitry if 
the load attached is small. 

J12 Connector (USB) 

Pin Function 

J12-1 USB GND 

J12-2 USB PWR 

J12-3 USB DP 

J12-4 USB DN 

J12-5 USB OTG ID 

Note: USB is one of the configurable wakeup sources (see "Power Management" section 
below). 

Note: Access to J12 should be restricted to only those authorized to use it (e.g. place PVSG 
inside a locked compartment, don't leave mating connector with standard USB connector 
connected to PVSG). 

J11 Connector (Ethernet) 

Pin Function 

J11-1 Ehternet TXP 

J11-2 Ethernet RXP 

J11-3 Ethernet TXN 

J11-4 Ethernet RXN 

Note: When Ethernet is enabled (see "Network Configuration" section below), access to J11 
should be restricted to only those authorized to use it (e.g. place PVSG inside a locked 
compartment, don't leave mating connector with standard Ethernet connector connected to 
PVSG). 

SMA Connector (External Antenna) 
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1.3. Status LED 
The LED on the PVSG is a multi-color LED that provides diagnostic information as follows 

(drawing is not to scale): 

 

Where: 

• Init indicates PVSG is performing some form of initialization (i.e. a portion of the PVSG 

is still booting up, or performing a configuration/programming step). 

• Waiting indicates nothing is connected to the PVSG (i.e. no CAN traffic detected, no 

USB connection, etc.). 

• Connected indicates something is connected to the PVSG. Use legend to decode 

connected network status. 

o CAN slot color codes as follows: 

➢ White: CAN bus inactive (no transmitted or received messages). 

➢ Green: CAN bus actively transmitting and/or receiving messages. 

➢ Yellow: Not used. 

➢ Red: CAN "bus off" or "error passive". 

 Note: it may be required to successfully transmit and receive a message to clear 

"error passive" state. 

• Error indicates an error has been detected. 

o Error codes shown in the diagram are examples.  
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o The error codes supported by the PVSG are available in the "Error Codes" section 

below. 

1.4. Error Codes 
The following table is a list of error codes supported by the PVSG. 

Error 
Code Description 

Detectable 
via Disabled Function(s) Recovery 

1:1 Server offline (not 
detected at all since 
startup). 

LED Server disabled. Reset PVSG. 

1:2 Server offline 
(detected at startup, 
but then later not 
detected). 

LED Server disabled. Reset PVSG. 

1:3 Configuration 
missing or invalid.  

Note: CAN bit rate 
defaulted to 250 
kbps.  

LED CAN transmission 
disabled. 

Configure PVSG. 

1:4 Invalid hardware. 

Note: CAN bit rate 
defaulted to 250 
kbps.  

LED CAN transmission 
disabled. 

Verify version of 
1051642 in use 
supports the hardware 
in use. 

2:1 USB 
communications 
failure. 

LED USB disabled. Reset PVSG. 

2:2 Server failed to load 
configuration. 

LED, 
Dashboard 

Default configuration. Configure PVSG. 

2:3 Server failed to 
mount internal 
storage. 

LED, 
Dashboard 

Server disabled. Reset PVSG. 

2:4 Power control 
offline. 

LED, 
Dashboard 

Power management 
disabled (PVSG will 
not sleep regardless 
of configured wakeup 
sources). 

Reset PVSG. 

2:5 Server internal 
service has stopped 
responding. 

LED, 
Dashboard, 

DM1 

Server disabled. Reset PVSG. 

2:6 Router offline. LED, 
Dashboard 

CAN receive/transmit 
not available. 

Reset PVSG. 

2:7 Shutdown not 
possible. 

LED, 
Dashboard 

Server shutdown is 
not possible due to an 
internal error. 

Reset PVSG. 

20:1 Missing modules. Dashboard, 
DM1 

Expected modules are 
missing from the 
system. 

Connect the missing 
modules. 
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Error 
Code Description 

Detectable 
via Disabled Function(s) Recovery 

20:2 Unknown modules 
detected. 

Dashboard, 
DM1 

Unexpected modules 
are connected to the 
system. 

Remove the unknown 
modules from the 
system. 

21:1 Custom logic: 
incompatible SDK. 

Dashboard, 
DM1 

Custom logic halted. Update PVSG and/or 
custom logic SDK in 
use. Consult document 
1051G05, Custom 
Logic User Guide for 
more details. 

21:2 Custom logic: 
resource utilization 
limits exceeded. 

Dashboard, 
DM1 

Custom logic halted. Debug/rework custom 
logic. Consult 
document 1051G05, 
Custom Logic User 
Guide for more details. 

21:3 Custom logic: failed 
to load. 

Dashboard, 
DM1 

Custom logic halted. Check PVSG 
configuration. 

21:4 Custom logic: 
terminated. 

Dashboard, 
DM1 

Custom logic halted. Debug custom logic. 
Consult document 
1051G05, Custom 
Logic User Guide for 
more details. 

21:5 Custom logic: 
stalled. 

Dashboard, 
DM1 

Custom logic halted. Debug custom logic. 
Consult document 
1051G05, Custom 
Logic User Guide for 
more details. 

Where possible, error information is also available in the PVSG Dashboard. See the 

"Dashboard" section of this document for more details. 

Error information is available in a periodic DM1 message broadcast by the PVSG on J1939 

interfaces that have management enabled (see "J1939 Configuration" section below). Each 

active Diagnostic Trouble Code (DTC) included in the DM1 message uses proprietary SPN 

52xxyy, where x and y are taken from the error code in the table above. E.g. SPN 520205 is 

error 2:5, and SPN 521510 is error 15:10. Each active DTC uses Failure Mode Identifier 

(FMI) 31, where 31 is defined by J1939-73 JAN2016 to mean "Condition Exists ... the 

reported SPN name spells out the component and a non-standard failure mode". Each active 

DTC sets Amber Warning Lamp (AWL) to flash slow and Red Stop Lamp (RSL) to off. 

 Note: LED off indicates the PVSG is not operating due to power off, or powered 

without an activated unmasked wakeup source. 
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2. Licensing 

Licensing is covered in several contexts with respect to the PVSG. The following is a 

summary of the contexts and specific license related references in this document: 

1. Section "Software Licensing & Copyright" below deals with the GPL code used in the 

PVSG that is licensed under the GNU General Public License (refer to section "GNU 

GENERAL PUBLIC LICENSE" at the end of this document). 

2. Section "Licensing" under "Configuration Tool" describes how a tool license is required 

to view or edit a PVSG configuration file. A configuration tool license is not required to 

download a PVSG configuration file to a PVSG. 

3. Section "Licences" under "Dashboard" describes how the dashboard provides an 

interface to install a tool license (e.g. Configuration Tool License) or a PVSG feature 

license. 

4. Section "Variants" under "Configuration Tool" > "Creating/Editing Configurations" 

describes how PVSG feature licenses can be used to enable functionality on certain 

variants of the PVSG. 

5. Document 1051G05, Custom Logic User Guide describes additional licenses for the 

development of custom applications and programming plugins. 

 Note: License and licence is used interchangeably in this document and in in the 

software. 

2.1. Software Licensing & Copyright 
The software running on the PVSG makes use of code built around the GNU General Public 

License, version 2. 

All Parker-modified GPL code continues to be licensed under the GNU General Public 

License. This license is available in its entirety at the end of this document. You may obtain 

the complete Corresponding Source code from us for a period of three years after our last 

shipment of this product, which will be no earlier than 2021-01-01, by a request to: 

Parker Hannifin Canada 

Electronic Controls Division 

1305 Clarence Avenue 

Winnipeg, MB R3T 1T4 Canada 

Please include the following with your request: "Request for source code corresponding to 

Parker-modified GPL code licensed under GNU General Public License in product PVSG 

1051000". This offer is valid to anyone in receipt of this information. 

All Parker-generated code is copyright Parker-Hannifin Corporation, all rights reserved. No 

part of this Parker code may be reproduced, published, or distributed in any form or by any 

means (electronically, mechanically, photocopying, recording or otherwise), or stored in a 

database or retrieval system, without the prior written permission of Parker-Hannifin 

Corporation in each instance. 



   

VA 1051000 | Parker Vehicle System Gateway  Page 14 of 100 
 © 2016-2019 Parker Hannifin Canada.  All Rights Reserved  

3. Security 

The following security related risk reductions factors are included in the PVSG to reduce the 

risk associated with security threats (including cybersecurity related threats): 

• Configuration file includes optional password-based protection to restrict view and/or 

edit access. Configuration files are encrypted to prevent unauthorised access and 

modification. See "Configuration Security" section below for details. This can be used to: 

o Prevent unauthorised users from modifying the installed configuration. 

o Prevent unauthorised users from reading an installed configuration and gaining 

unapproved knowledge of the system. 

• Wireless configuration includes optional support for connection-oriented security modes 

to restrict access when wireless is enabled. See "Network Configuration" section below 

for details. 

o The configuration warns the user if an acceptable level of security has not been 

configured. 

• User access control provides optional support for restricting access to certain PVSG 

features. See "User Accounts" and "User Access Control" sections below for details. 

o The configuration tools warns the user if the specified user account password does 

not meet specific security criteria. 

• Critical data exchange with the PVSG (e.g. configuration, authentication) uses a secure 

session to prevent eavesdropping and man-in-the-middle attacks. This uses industry 

standard transport layer security (TLS) mechanisms to protect the system and its users. 

• Data signing techniques are employed where necessary to validate the authenticity of 

specific data and its sender. 

• Open TCP/IP ports limited to only required ports in use. 

• Some critical functions are protected by hardware separation. 

• Internal access to the PVSG is protected via a layered security approach to prevent 

unauthorised access. 

When incorporating the PVSG into a system with security requirements, ensure that the 

optional security related PVSG features are configured appropriately and that any system 

level security related risk reduction factors are also considered to reduce the risk associated 

with security threats (including cybersecurity related threats). 

Contact Parker for more information should you have questions not covered by this 

document. 
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4. Embedded Software 

Embedded software for the PVSG is distributed as a deployment package, software part 

number 1051642. 1051642 is pre-programmed in the PVSG, and upgradable using the update 

tool (1051606). 

4.1. J1939 
J1939 Controller Applications (J1939 CAs) are configurable for each physical CAN interface 

via the configuration tool (1051646). 

4.1.1. Version Information 

Version information is available on each configured J1939 CA via the J1939 Software 

Identification (SOFT) and Component Identification (CI) messages. The information can be 

requested from the CA using the J1939 Request (RQST) message. Note that the information 

returned by each CA will be identical. The response for both SOFT and CI is compliant with 

983F17.01A (internal Parker ECD Standard). In the case of the SOFT message, the fields 

present are as shown in the following table. 

Field 
Name Use 

APP The version of the 1051642 embedded deployment package. 

PAR Information pertaining to the installed configuration. This includes the 
configuration version, label and file name information. 

MODE The current operating mode of the product. Valid values are "Run" and "Test". 

FMT The specification with which the J1939 SOFT output is complaint. Currently, this 
is 983F17.01A. 

For the Component Identification message, the final SAP number and final serial number are 

published for the "Model" and "Serial Number" fields respectively. The format is governed 

by J1939DA August 2015. 

Example: 

Below is an example trace from CANsniff: 

Timestamp | Len. | PGN | P SA DA | Data 

---------------------------------------------------------------------------------- 

12:57:40.260 | 3 | 00EA00 | 6 F9 00 | DA FE 00 | 

12:57:40.307 | 94 | 00FEDA | 6 00 FF | 04 41 50 50 2C 31 30 35 31 36 34 32 2C 56 30 2E 35 

42 32 37 2A 50 41 52 2C 2C 56 30 2E 30 42 31 2C 31 30 35 31 4D 30 36 20 54 31 31 38 2C 

31 30 35 31 4D 30 36 5F 30 34 41 5F 54 31 31 38 2E 70 76 73 67 63 2A 4D 4F 44 45 2C 52 

75 6E 2A 46 4D 54 2C 39 38 33 46 31 37 2C 52 30 31 41 2A | 

APP,1051642,V0.5B27*PAR,,V0.0B1,1051M06 

T118,1051M06_04A_T118.pvsgc*MODE,Run*FMT,983F17,R01A* 

13:05:19.997 | 3 | 00EA00 | 6 F9 00 | EB FE 00 | 

13:05:20.031 | 25 | 00FEEB | 6 00 FF | 2A 31 36 32 37 35 30 2A 50 52 4F 31 30 35 31 30 30 

31 52 30 30 3F 3F 2A 2A | *162750*PRO1051001R00??** 
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The following information was returned upon request of the SOFT message: 

APP,1051642,V0.3B18*PAR,,V0.0B1,1051M06 

T118,1051M06_04A_T118.pvsgc*MODE,Run*FMT,983F17,R01A* 

The following information was returned upon request of the CI message: 

*162750*PRO1051001R00??** 

where the final SAP number was set to "162750" and the final serial number was set to 

"PRO1051001R00??". 
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5. PC Software 

5.1. Overview 
PC software for the PVSG is distributed via a single installer (1051605). This installer 

currently installs the following components: 

Component Name Software Number 

Core Driver (*) 1051602 

Update Tool 1051606 

Configuration Tool 1051646 

* - The core driver is made up of more than just 1051602, but 1051602 includes the 

dashboard which is the only user-visible piece. 

 Note: Refer to the "Software Release Notes" section in this document to determine 

the correct version of PC software to use with the version of 1051642 used in the 

PVSG. 

 Note: The current installed version of the PC software (1051605) can be determined 

from the dashboard: 

 
The current installed version of the PC software (1051605) can also be determined by going to Control 

Panel > All Control Panel Items > Programs and Features and examining the version reported by 

Parker Vehicle System Gateway Suite. For example: 

 

 Note: The security principal of an administrator may be required to install the PVSG 

PC software. 

5.1.1. System Requirements 

The PVSG PC Software currently requires Windows 7 / 10 (32-bit or 64-bit), a minimum 

screen resolution of 1024 x 768, and USB 2.0 or higher. 

5.1.2. File Types 

The following file types are used by the PVSG PC software. 
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File 
Extension Type Used By Description 

.pvsgs PVSG 
Software 

Update Tool 
(1051606) 

PVSG embedded software package. 
Created by Parker Engineering. 

.pvsgc PVSG 
Configuration 

Configuration 
Tool (1051646) 

PVSG configuration source file. 
Configuration can also be distributed in 
this format. 

.pvsgapp PVSG Custom 
Logic 

Configuration 
Tool (1051646) 

PVSG custom logic file (custom 
application or custom programming 
plugin). Contact Parker for more details. 

5.1.3. USB Driver Software Installation 

The first time a PVSG is connected to a PC via USB, Windows will initiate a PVSG USB 

Driver Software installation. The PVSG PC Software should not be used until the PVSG 

USB Driver Software installation has completed: 

 

5.1.4. Management Connectivity 

It is possible to connect to the PVSG for management purposes via 3 interfaces: 

• USB 

• Ethernet 

• Wireless 

The PVSG PC drivers can handle all 3 types of communication link. From an architectural 

perspective, Ethernet and Wireless are the same mechanism and are categorised herein simply 

as "Network" since the underlying layer (TCP/IP) is the same for each. The active 

communication mechanism can be selected from the Dashboard application within the 

Connection tab. 

5.2. Dashboard 
The dashboard is the user-visible portion of the core driver (1051602) that is the single 

endpoint for PVSG communication with the PC. Any PC tool(s) needing to communicate 

with the PVSG does so via this service. 
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5.2.1. Accessing the Dashboard 

The dashboard will start automatically when you log in to Windows as a tray application. 

Connection change notifications will be shown near the system tray area, for example: 

 

The dashboard tray application can be opened by double-clicking the 'Parker' icon in the 

system tray area: 

 

When closed, the dashboard will be hidden and continue to run in the background. The 

dashboard tray application can be permanently shutdown using the Shutdown option on the 

dashboard dock. The dashboard dock can be accessed by clicking the dock button in the top 

right corner: 

 

Or pressing Ctrl + D when the dashboard is in focus. The dock appears at the bottom of the 

dashboard window: 
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The dock provides quick access to other PVSG tools as well as access to the help files and 

version information. 

If needed to be relaunched after a permanent shutdown, run PVSG Dashboard (shortcut 

added to Windows start menu by default as part of the installer (1051605) under Parker > 

ECD > PVSG). 

 Note: Shutting down the dashboard does not shut down the portion of the core driver 

(1051602) that runs as a Windows service. If you need to restart the core driver, 

select Restart Service from the dashboard dock. Alternatively, from the Windows 

start menu select Run, enter services.msc and click OK. This should launch a 

Services screen listing Windows services. In the list of services, find PVSG Driver 

Core Manager, right-click on it and select Restart. The security principal of an 

administrator may be required to restart the PVSG Driver Core Manager service. If 

you can't restart the service, restart Windows. 

5.2.2. Licences 

PVSG feature licences and tool licences can be installed via the licence manager. 
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5.2.2.1. PVSG 

PVSG feature licences can be obtained from Parker Hannifin Corporation, or are pre-installed 

on a PVSG unit. To install a licence, copy the licence data provided by Parker to the 

Windows clipboard, and click the Paste button under New Licence. The PVSG must be 

restarted (per the prompt) in order for the new licence to take effect. The state of any installed 

licence is reported under Current Licence along with a summary of the enabled feature state 

via the Features button. 

 Note: the state of any installed licence is only available when the PVSG has a valid 

configuration installed. 

5.2.2.2. Tools 

This section provides easy access to licence data for installed PVSG tools. Refer to the 

specific tool help for more details on the licence in relation to that particular tool. 

5.2.3. Overview 

The Overview tab provides a quick view of the current state of the connected PVSG (if one 

exists) and the current state of the PC drivers, including which applications are connected. 
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 Note: The Configuration Version number is composed as follows: the first three 

numbers match the major version, minor version, and build number entry in the 

configuration tool, and the fourth number (is known as the 'runtime configuration 

version') is a number updated by PVSG whenever configuration is modified 

internally (incremented per change at shutdown) or a new configuration is installed 

(set to 0). 

Driver version information can be obtained by selecting the About option on the dashboard 

dock: 

 

The Components tab provides detailed information on all major driver components: 



   

Page 23 of 100  VA 1051000 | Parker Vehicle System Gateway 
 © 2016-2019 Parker Hannifin Canada.  All Rights Reserved.  

 

Note that the Copy Info button can be used to help provide diagnostic information to Parker; 

this will copy all of the component version information to the Windows clipboard which can 

then be pasted into an email, for example. 

Active target errors are shown within the Status panel. The error codes match those shown 

on the PVSG's status LED and the "Error Codes" section within this document can be used to 

lookup the meaning. 
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5.2.4. Connection Information 

The bottom right corner of the Dashboard provides connection information summary. 

 

The connection status indicator on the left reports the connection state as CONNECTED or 

NOT CONNECTED. When connected, the connection method will be shown as USB ( ) 

or network ( ). In addition, when connected, a lock symbol ( ) will appear when a 

secure session has been established with the PVSG. 

 Note: A secure session is required to perform critical data exchange with the PVSG 

(e.g. configuration, authentication). 

The Connection panel provides an interface to select between available target connection 

methods (USB or Network (including Ethernet and wireless)). 

5.2.4.1. USB 

USB is the primary management connection mechanism. If another management connectivity 

mechanism is in use and the USB connection becomes connected, communication will 

transition to the USB link once a connection is established. 

5.2.4.2. Network 

The default network connection mechanism is Ethernet. If Ethernet and/or wireless is enabled 

in the configuration and depending on whether Ethernet is physically connected to the target 

or not, one or the other will become active whenever the USB link is determined to be 

disconnected. If wireless is enabled in the configuration, the radio will power up and down as 

necessary when the network connection mechanism is available. 

All network configuration can be done via the configuration tool (1051646) from the 

Network Configuration menu option. 

Discovery 

The network communication mechanism provides a discovery feature which allows one or 

more PVSGs to be discovered on the network. This allows such devices to be connected to 

without knowing their address details. For this to work, discovery must be enabled in the 

configuration and the discovery port must be known. The discovery mechanism uses 

broadcast UDP transmissions, and so PVSGs can ONLY be discovered within the broadcast 

domain of the network to which they are connected. The broadcast domain is controlled by 
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both the physical topology of the network and the addressing scheme in use. Importantly, 

note that broadcast transmissions are never forwarded by network routers. The PVSG(s) 

which you wish to discover and the PC performing the discovery operation must be on the 

same network segment and be visible to one another. 

The discovery interface can be accessed from the dashboard by going to the Connection 

panel and clicking on Network. This will bring up the following screen. 

 

Click Discover to discover available PVSGs. Available PVSGs will appear in the Connection 

area of the screen. Select the desired PVSG and then click Connect to establish a connection 

with it. 
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Ports 

As is good practice with services which use TCP/IP communication, the ports used are 

configurable. Note that the default values have been carefully chosen to avoid collision with 

known standard ports, and so should not be changed by the user without very good reason. 

5.2.5. Client Information 

The dashboard provides information on the clients connected to the target. The Connected 

Applications panel provides an interface to select between connected applications. 

5.2.5.1. Connecting a RP1210 Client 

The PVSG supports a subset of RP1210C (reference TMC RP 1210C - Windows Application 

Program Interface) to provide diagnostic tool access to all of the PVSG CAN, J1939 and 

J1708 interfaces. 

In order to connect a RP1210-based tool to the PVSG (e.g. CANsniff), the PVSG DLL (i.e., 

PH105132) must be specified as the RP1210 Vehicle Datalink Adapter (VDA) to use. For 

example, CANsniff supports a built-in RP1210 chooser that allows you to choose the RP1210 

VDA to use. Note other tools may require other steps to be taken to specify the PVSG DLL. 
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 Note: The physical CAN bus with which an RP1210 client is associated is set by 

channel selected for the supported device when specifying PH105132 (third section 

of the screen above Supported Channels for the Selected Device). The channel 

number is the physical CAN bus number (i.e. Channel 1 is CAN 1, Channel 2 is CAN 

2, etc.). 

Once connected, the client can be seen from the dashboard tray application, Connected 

Applications panel. 
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Clicking on any client application will bring up a menu with actions that can be performed 

upon the application attached to the PVSG. 

 

 Note: A single application may contain multiple "clients". In terms of RP1210 

clients, for example, a single application instance may open more than one RP1210 

client connection. Each logical connection which a connected application owns is 

shown as a tab in the properties window: 
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5.2.5.2. Properties 

The Properties window shows various metric information about a particular client 

connection. For CAN (or J1939) type connections, it also allows the active CAN bus to be 

changed: 

 

Notes: 

• The virtual CAN bus connection (the Virtual tab seen above) is currently a stub (non-

existent). 

• Some applications (e.g. CANsniff) may make more than one RP1210 client connection 

and all of the RP1210 client connections associated with a particular instance of an 



   

VA 1051000 | Parker Vehicle System Gateway  Page 30 of 100 
 © 2016-2019 Parker Hannifin Canada.  All Rights Reserved  

application may need to be updated to the same CAN bus in order for the application to 

function properly. 

5.2.5.3. Terminate 

The Terminate option can be used to stop the connected application's process: 

 

 

This terminates any logical client connections and then shuts down the application's process. 

5.2.5.4. Show Me 

The Show Me option can be used to give visual focus to the selected application's process. 

5.2.6. User Access Control 

The dashboard provides the ability to log in to the PVSG. By default, the anonymous user is 

logged in. The current user will be logged out whenever an attached management device is 

disconnected, or the PVSG is rebooted. The Login and Logout buttons may be used to log in 

as a new user, or log out as the current user respectively: 
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If a user is already logged in, the Switch User option appears: 

 

When logging in (or switching user), the User Login window is displayed: 

 

Entering the correct username and password will log the respective user in. Entering an 

incorrect username and password will log in the anonymous user. 
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5.2.7. Logs 

The Logs tab provides an interface to retrieve logs, including system logs and fault logs. The 

log type can be selected using the toolbar buttons: 

 

Refresh the logs by clicking the Request button in the top right corner. 
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The listing of logs are displayed in reverse chronological order. 

To export logs to a .csv file, select Export button in the top right corner. 

For system logs, the following events are logged: 

• Configuration failed to load 

• eMMC failed to mount 

• Softdog related events (server services/router (XMC)/power control (M0) gone missing) 

• Configuration updated (including username of user who performed the update) 

• System update events 

• Shutdown provider stopped 

• USB service stopped 

For details on the data logged within a fault log, see the Fault Logging section under 

Configuration Tool. 

5.2.8. System 

The System tab provides access to CAN metric information and the system map. 
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5.2.8.1. CAN Metrics 

 

This shows the number of CAN messages being received by the PVSG per second, for each 

available CAN bus. The approximate bus load is also shown as a percentage, given the 

configured baud rate. The traffic graph uses the following colours: 

• Green. 0% <= CAN bus load < 40% 

• Yellow. 40% <= CAN bus load < 70% 

• Red. 70% <= CAN bus load <= 100% 

 Note: The CAN bus metric colour scheme is merely used to provide a visual aid. 

It does not provide any indication as to the state of the system and should not be 

used as such. 

5.2.8.2. System Map 

The System Map tab shows a visual representation of the modules connected to the system in 

which the currently attached PVSG resides. Clicking Request retrieves the module data 

currently stored by the PVSG. Clicking Probe forces the PVSG to detect new modules first. 

Modules are detecting by the PVSG making a "J1939 global request for address claim" on all 

configured CAN buses (see the "Configuration Tool" section for details on how to configure 

module detection). Additional information is retrieved from modules which respond, where 

possible. 
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The icons shown within a module card differ depending upon the state of the module: 

Icon Description 

·  

Module is known, and is expected on the system. 

·  

Module is not known, and is not expected on the system. 

·  

Module is missing from the system. 

·  

The configuration holds software for this module, and it can be updated. 

Clicking on a particular module shows additional information, where available: 
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If a module is "known" to the system (i.e. it is present in the configuration), an extra section 

appears under the module header, known as the Module Toolbox: 

 

Several icons/buttons are available (note that the module toolbox contents are dynamic and 

different icons/buttons will appear depending on the state of the module and the installed 

configuration): 

Icon/Button 
Function 
(click) Description 

·  

None Indicates that the identity of the detected module matches that 
set in the configuration. 

·  

Updates 
module 
software 

Only appears if the module ID matches and the module is 
configured for software updates (i.e. the configuration contains 
software for this module). When selected, the module will be 
updated with the software contained within the configuration. 

If an operation is currently in progress on a module, a progress bar is also shown within the 

module toolbox: 

 

The System Toolbox is shown at the top of the system map: 
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This contains available "global" (to the system) actions. 

5.2.8.3. Update 

Opens a popup giving access to system software update options: 

 

Modules which are available for software update are shown in the Available column. 

Individual modules can be updated by clicking the arrow on the module info within the 

Available column: 
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Using the Update All and Update All on Bus buttons at the bottom of the popup, all eligibile 

modules and all eligible modules on a chosen CAN bus can be updated respectively. 

Operations currently in progress are shown under the In Progress column. Operations which 

cannot start yet are shown within the Pending column. 

 

Concurrent operation policies are controlled via the configuration tool. 

System module update operations are logged in the system log (refer to Logs section above). 

In the case of failure, the meaning of the returned status codes are dependent upon the 

protocol in use. 

5.2.8.4. Vansco Flashload-over-CAN 

Code Description 

-9 The system module software file header was malformed. 

-61 There was insufficient memory available to perform the operation. 

-61 The system module software file was empty. 

-125 Operation cancelled. 

-131 A general error occurred which could not be recovered from. 

5.2.9. Manage 

Management options are available under the Manage tab. If no management options are 

available for the currently logged in user, the following is seen: 



   

VA 1051000 | Parker Vehicle System Gateway  Page 40 of 100 
 © 2016-2019 Parker Hannifin Canada.  All Rights Reserved  

 

To access management options, log in as a user (if user management is not configured, all 

possible management options are displayed without a user being logged in). 

 

Possible management options are listed below. 

Option Description 

Erase Fault 
Log 

Erases all logs currently stored in the fault log database. This action cannot 
be undone. 

5.2.10. Settings 

The Settings tab gives access to available user settings: 
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When settings are changed, the user is prompted to save them: 

 

The following settings are available: 

• User Interface: Theme. This sets the current visual theme from two available options: 

o Light 

o Dark 

• J1939: TP BAM Inter-Packet Space: Sets the time interval between consecutive data 

packets on a J1939 Transport Protocol Broadcast Announce Message transmission. The 

J1939 standard states that this should be set between 50ms and 200ms. 10ms is also 

provided as an optional performance enhancement at the user's discretion. 

 Note: Once changes are saved, they are not applied until the relevant PC software 

component is restarted. 
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5.3. Update Tool 
The update tool may be used to update the version of the software (1051642) installed on the 

PVSG. The update tool requires a USB connection to the PVSG to update. 

5.3.1. Accessing the Update Tool 

The update tool can be accessed by using the PVSG Update shortcut added to the Windows 

start menu by default as part of the installer (1051605) under Parker > ECD > PVSG. 

 

In order to update a PVSG, with the PVSG connected, run the update tool, select the 

appropriate file and click Start. Then follow the on screen instructions to complete the update 

process. 

 Note: The update tool also provides a command line interface. Locate pvsgupd.exe 

(installed as part of the installer 1051605), and run "pvsgupd.exe -h" to get a listing 

of all of the available commands. 

5.3.2. Downgrading 

In some circumstances, it may be desirable to "downgrade" the version of embedded and PC 

software to an earlier version than that currently installed. When doing this, it is important to 

ensure that the version of PC software installed always matches the version of embedded 

software installed. The release notes for the particular version in question should be consulted 

to determine compatibility. Downgrading steps are outlined below. 
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1. Ensure that the version of PC software (1051605) installed matches the version required 

for the installed embedded software (1051642). Consult the release notes to determine 

the correct version. 

2. Downgrade the embedded software (1051642) to the desired version. 

3. Downgrade the PC software (1051605) to the version required by the now installed 

embedded software (1051642). 

5.4. Configuration Tool 
The PVSG is configured using the configuration tool. 

5.4.1. Accessing the Configuration Tool 

The configuration tool can be accessed by using the PVSG Configuration shortcut added to 

the Windows start menu by default as part of the installer (1051605) under Parker > ECD > 

PVSG. Configurable elements are accessible via the menu system on the left side of the tool 

and are organized by area. 

 

 Note: The configuration tool also provides a command line interface. Locate 

pvsgcfg.exe (installed as part of the installer 1051605), and run "pvsgcfg.exe -h" to 

get a listing of all of the available commands. 
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 Note: The configuration tool will show/popup (wherever applicable) a symbol on its 

interface to bring attention to: 

• an error (with a red color scheme), 

• a warning (with a yellow color scheme), or 

• information (with a blue color scheme) 

Further information can often be found on the symbol tooltip (place the mouse cursor over 

the symbol to access). Some examples: 

 

 

5.4.2. Licensing 

The configuration tool behavior is dependent upon a license. If no license is installed, the tool 

can only be used to load a configuration and transfer it to the PVSG. Viewing/editing 

configurations require a specific license to grant that privilege. To install a license, go to Edit 

> License. The license uses a challenge/response system whereby the local computer 

generates a challenge value specific to that PC. This is then used to generate a response value 

which provides access to certain features. Note that licenses are locked to a particular PC; the 

mechanism used to do this is proprietary and confidential to Parker. 
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Licenses are currently available from Parker ECD Engineering. 

Once a license is installed, a summary is shown: 
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Note that the configuration tool must be launched in the security principal of an administrator 

in order to install a license. 
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5.4.3. Creating/Editing Configurations 

A blank configuration is created by default every time the tool is started. To destroy any 

unsaved changes and start a new configuration, select File -> New. 

5.4.3.1. Variants 

The configuration tool supports multiple variants of the PVSG product. The configuration 

tool allows all options and features to be configured irrespective of which variant of PVSG is 

connected or selected in the Variant Manager. If a feature or option is configured which is not 

supported on the variant on which the configuration is deployed, the particular feature or 

option will be disabled and the configuration will fall back to a default state. 

In order to assist with understanding the particular features available on a particular variant, 

the Variant Manager is available. Open the Variant Manager by selecting Variant from 

the menu bar and then the Summary option. This can also be accessed using the icon in the 

bottom right-hand corner of the tool. 

 

The Overview view shows the features which are available on the selected variant. A feature 

can be configured in one of 3 states, per the table below. 

Feature State Description 

Enabled 

 

The feature is available by default on the selected variant. 

Enabled with 
License 

The feature is not available by default on the selected variant, but can be 
enabled with the addition of a license. 



   

VA 1051000 | Parker Vehicle System Gateway  Page 48 of 100 
 © 2016-2019 Parker Hannifin Canada.  All Rights Reserved  

Feature State Description 

 

Disabled 

 

The feature is not available on the selected variant. 

The Conflicts  view shows any features which have been configured in the configuration but 

are not available on the selected variant. 

The following is a table of supported variants, and features supported: 

Features / 
Variant 1051001 1051002 1051003 1051004 1051005 1051006 1051007 

5 - CAN 

       

1 - J1708 

       

Internal 
Storage 

4 GiB 4 GiB 4 GiB 4 GiB 4 GiB 4 GiB 4 GiB 

Wireless Core 

       

External 
Antenna        

Fault Logging 

       

Module 
Management        

System Module 
Update        

CAN Router 

       

DLA 

       

Custom 
Applications        

Custom 
Programming 
Plugins 

       

Sleep Mode 2 
Supported        

5.4.3.2. Opening and Saving Configurations 

Configurations can be opened/saved using the File -> Open and File -> Save menus 

respectively. The .pvsgc format is used for configuration files (See File Types table above); 

this format is a proprietary format belonging to Parker. Note that these files cannot be edited 

manually and should only be modified using the configuration tool. 
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Unsaved changes to the current configuration are indicated by an icon in the status bar 

(bottom right corner): 

 

5.4.4. Keyboard Shortcuts 

The following 'special' keyboard shortcuts can be used: 

Keyboard 
Shortcut Area Active Function 

Ctrl + S Global (all 
areas) 

Saves the current configuration (equivalent to a File > Save). 

Ctrl + C Message 
filter list 
editor 

Copies the currently selected message filter entry/entries. 
Note that groups of entries may be selected by selecting the 
first entry, holding the SHIFT key and then selecting the last 
entry. 

Ctrl + V Message 
filter list 
editor 

Pastes any message filter entries on the clipboard into the 
current list. 

Del Message 
filter list 
editor 

Deletes the currently selected message filter entry/entries. 
Note that groups of entries may be selected by selecting the 
first entry, holding the SHIFT key and then selecting the last 
entry. 

Ctrl + A Message 
filter list 
editor 

Selects all message filter entries in the current view. 

Ctrl + left 
mouse 
click(s) 

Message 
filter list 
editor 

Allows multiple non-contiguous message filter entries to be 
selected/deselected for further operation (copy, delete, etc.). 

Shift + left 
mouse click 

Message 
filter list 
editor 

Allows multiple contiguous message filter entries to be 
selected/deselected for further operation (copy, delete, etc.). 

5.4.5. J1939 Configuration 

The PVSG contains 5 physical CAN interfaces, each of which is capable of supporting J1939 

communication. J1939 configuration can be adjusted using the J1939 Management section 

under the J1939 menu. 
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To support J1939, an interface must have its J1939 Capable property set. This denotes that 

the interface is connected to a J1939 capable network but does not necessarily create any 

Controller Applications (CAs) on it. To create a CA which can be used for management 

purposes (for SOFT and CI retrieval, for example), the Management Enabled property must 

also be checked. When both J1939 Capable and Management Enabled are checked, the 

management configuration fields become visible which allows the management source 

address and NAME field to be configured. 

 Note: A periodic DM1 message is broadcast on J1939 interfaces that have 

management enabled. See "Status LED" section above for details on how error 

information is made available in a DM1 message. 

5.4.6. Power Management 

Power management features of the PVSG can be controlled via sub-menus of the Power 

Management menu. Currently, this allows the wakeup sources to be selected, via the 

Wakeup Options section. 

When one or more enabled wakeup sources become active, the PVSG will wake up. When all 

enabled wakeup sources are no longer active, the PVSG will initiate a proper shutdown and 

go to sleep. 

 Note: There is a risk of corrupting the PVSG filesystem if power is removed from a 

PVSG prior to allowing a PVSG to go to sleep. Therefore is it recommended to 

always use Wakeup control to put the PVSG to sleep if power needs to be removed. 
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 Note: The Wakeup timeout defines the duration that all enabled wakeup sources 

must be idle for before being considered inactive, allowing the PVSG to go to sleep. 

 Note: When wakeup is enabled (any GPIO 1 .. USB checkbox (as seen above) is 

checked), upon waking (regardless of the wakeup source), the PVSG will require the 

Wakeup timeout to expire before going to sleep. 

5.4.6.1. Sleep Mode 

The Sleep Mode setting controls what the PVSG does when it goes to sleep. This happens 

when all of the unmasked wakeup sources become inactive. Available options are 

documented in the tables below. Note that the available sleep modes depend upon the variant 

used. 

Sleep Mode 

Description 

On Wakeup 

Supported Variants 

Router 

Server 

Sleep Mode 1 

Sleep mode with the lowest current consumption possible. Slower to fully wake from sleep 

than sleep mode 2. 

Restart 

Restart 

All 
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Sleep Mode 2 

Wakes from sleep much faster than sleep mode 1, but at the expense of slightly higher current 

consumption. 

Restart 

Resume 

1051004 only 

Example Start-up Times 

Function On Power Up Sleep Mode 1 Sleep Mode 2 

Critical Tasks (CAN routing) 456 ms 432 ms 97.2 ms 

Non-Critical Tasks (ex. DLA 
functionality, product reprogramming) 

9.92 secs 7.89 sec 468 ms 

Example Current Draw 

Sleep Mode 12V 24V 

Sleep Mode 1 3.2 mA 1.7 mA 

Sleep Mode 2 11.4 mA 5.9 mA 

5.4.7. Network Configuration 

PVSG network configuration is controlled by the Network Configuration menu. This menu 

can be used to configure a PVSG to use Ethernet and/or wireless as a management connection 

interface. For a description of each network configuration option please refer to the tool-tip 

that appears when hovering over an option in the configuration tool. 



   

Page 53 of 100  VA 1051000 | Parker Vehicle System Gateway 
 © 2016-2019 Parker Hannifin Canada.  All Rights Reserved.  

 

5.4.8. Time and Date 

PVSG Time and Date configuration is controlled by the Time/Date Configuration menu. 

This menu allows the user to specify the time/date source (either None or J1939) for setting 

the PVSG Real Time Clock (RTC) time and date values. For a description of each Time/Date 

Source option, please refer to the tooltip that appears when hovering over a non-selected 

time/date source option in the configuration tool. 
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If the J1939 option is selected, the physical CAN bus where the external source resides as 

well as its source address need to also be specified. Note that the user is required to enable 

and configure (via the J1939 Management menu) the J1939 management settings for the 

chosen Physical Interface (which houses the time/date source, a J1939-based node). The 

time and date configuration takes effect as soon as the configuration becomes active. The 

RTC will only be set via J1939 once per power session; once the first received message has 

been processed, all future time/date messages received by the PVSG will be ignored until the 

PVSG is power cycled. 

Regardless of the Time/Date Source option selected, the RTC will contain a random time 

and date every time the PVSG is power cycled (until the time/date is set, if applicable). 

5.4.9. System Modules 

This section relates to other modules within the system to which the PVSG is connected. 

5.4.9.1. Module Management 

"Modules of interest" in the target system can be identified within the module management 

interface. A module's core identity is comprised of its J1939 source address and the physical 

CAN bus on which it resides. It is possible to further refine a module's identity by using the 

following pieces of information: 

• J1939 NAME Field 

• J1939 Software Identification message (PGN 0xFEDA) data 

• J1939 Component Identification message (PGN 0xFEEB) data 
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Selecting the Add button under the Module Management configuration applet allows a new 

module to be created: 

 

The J1939 source address and physical CAN bus should be set, along with a descriptive name 

for the module. Clicking Create adds the module to the current configuration and shows a 

new Module Card: 
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The module card data changes depending upon the configuration: 
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Each module offers options of Edit (covered in the following section) and Delete which, as 

the name suggests, allows the module to be removed from the configuration. 

If the PC is connected to a PVSG, the Query button queries the information from the 

modules connected to the system in which the currently connected PVSG resides. The icon in 

the top right corner of the module information control shows the status of the module in the 

current system, if the PC is connected to a PVSG. It can show one of four states: 

• Not queried. It isn't currently known whether this module exists or not. Icon is blue. Click 

Query to begin. 

• Not connected. The module is not present in the current system. Icon is red. 

• Connected, but the identity does not match. The module source address was found on the 

particular CAN bus, but the identity was different than configured. Icon is yellow. 

• Conencted, and the identity matches. The module source address was found on the 

particular CAN bus, and the identity matches that which was configured. Icon is green. 

Each module may contain multiple identities; a module's core identity is formed from the 

J1939 source address and CAN bus though it is possible under certain conditions for a 

particular source address and CAN bus combination to change meaning, or be used for 

multiple purposes within a single system. An example of this is a blank module, containing 

no application software; such modules often use 0xFD as their J1939 source address until 

they have been programmed with a valid application. Alternate identities can be used to 

handle such cases, by using extra identity information to identify a unique instance of a 

module and then apply a different behaviour, such as installing different module software. A 

module must contain a primary identity, and may contain multiple alternate identities. The 

number of available identities is indicated in the module card header: 

 

The module card can show information about alternate identities by cycling through the 

available identities: 
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If modules are detected on the system which are not listed in the configuration, an Unknown 

button appears. Clicking this shows the Unknown Modules Popup: 

 

Modules listed here can be added to the configuration by clicking the arrow button beside 

each set of module information. When using this method, a module is added with all known 

properties selected. They can be removed as required using the Edit System Module 

interface. 
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5.4.9.2. Editing a Module 

A module can be changed by clicking the Edit button on a particular module instance. This 

shows the Edit System Module window: 

 

This allows the user to specify which components make up a module's identity. Additional 

alternate identities may be added and switched between using the toolbar buttons at the top of 

the window: 

 

 

Note that when editing an alternate identity, only a subset of the module properties may be 

available for editing; in order to edit these properties, switch to the primary identity. 

J1939 NAME 
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The J1939 NAME field components can be used to identify a module. To enable this, tick the 

box labelled Does J1939 NAME form part of the identity?. Values can then be specified 

for the individual fields of interest. For fields which are not required to be part of the identity, 

an askerisk (*) should be placed to indicate that any value is acceptable. 

Software Identification 

To make software identification a part of a module's identity, tick the box labelled Does 

software identification form part of the identity?. The SOFT message format must then be 

specified: 

• Parker. The SOFT message uses the format defined in 983F17. Currently, R00A, R01A 

and R02A revisions of the standard are supported. Advanced element matching is 

supported. 

• Raw. The SOFT message will be inspected as a raw string. Only basic value matching is 

provided. 

When the format is chosen, use the Add Element button to add a new element to the identity: 

 

The element, the instance of that element and the parameter within that element must be 

chosen. Refer to 983F17 for a description of the format. The value field should be populated 

with the ASCII string data which should be expected for the particular element and parameter 

combination. Click Create to finish. 

In raw mode, only basic string comparison is supported. The user may enter any number of 

fields which the SOFT message data should contain: 
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In Parker format mode, the view is enhanced: 
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 Note: Changing the software identification format when elements already exist will 

erase any currently stored elements. 

A matching element can be removed by clicking the Delete icon to the far right side of the 

particular element to remove. 

Component Identification 

Component identification follows the same principle as software identification. To make 

component identification a part of a module's identity, tick the box labelled Does component 

identification form part of the identity?. The user may choose to match the following 

fields: 

• Model. The "model" field from the component identification message. See J1939-71. 

• Serial Number. The "serial number" field from the component identification message. 

See J1939-71. 
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5.4.9.3. Module Software 

This section controls whether the configuration stores software for this module or not, and if 

it does, which software is used and how and when it is deployed. 

To attach a pre-configured software element to this module, tick the box labelled Store 

software for this module?. Software can be selected and removed using the Add and 

Remove buttons: 

 

Clicking the Add button shows the Select Module Software dialog: 
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This dialog allows the user to select from software already loaded into the configuration via 

the Software Archive interface (see below). Clicking Select attaches the selected software to 

the module. 

Note that the Remove button does not remove the software item from the configuration; it 

simply disassociates the software with the current module. 

When selected, some detail on the software is shown: 

 

Note that the detail shown will change depending upon the file type selected and the 

information actually available in the selected file. 

The supported download mechanisms and download policies are per the following: 

Download 
Mechanism Description 

Vansco Flashload-
Over-CAN (VFOC) 

The Vansco Flashload-Over-CAN-Protocol per Parker document 
983F08. 

Download Policy Description 

Manual Start The module software is updated via manual invocation from a user 
via the PVSG dashboard (see "Dashboard" section in this 
document). 
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5.4.9.4. Software Archive 

The Software Archive holds all system module software for this configuration; that is, the 

software which is used by the external modules attached to the PVSG system. 

Software must be added here before it can be used by a module. 

 

To add a software item, click the Add button. This adds a blank software item: 

 

The red exclamation mark icon indicates that there is an error with the software item. This is 

expected because it has not yet been configured. 

To edit a software item, click the Edit button: 

 

Edit the Name and Description and select a software File to use. When complete, click Save. 
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Note that it is not required for the software item name to be unique within a configuration. 

The information bar at the top of the Software Archive applet shows information on the 

software stored: 

 

This includes the total size of the software stored, and whether any items are unused. Note 

that unused software items waste space and so it is encouraged to remove them when 

possible. 

When software archive editing is complete, click the Save button to save the changes. 

5.4.9.5. Module Management Settings 

This section covers settings which are related to the PVSG module management system. 

 

Setting Description 

Missing module 
action 

Controls the action taken when a module is determined to be missing from 
the system. Possible actions are Do Nothing, or Show a Fault (error code 
20:1, see "Error Codes" section within this document for details) . 

Module 
matching 
scheme 

Controls how the PVSG determines whether a module matches its 
configured identity or not. Available options are using any identity, or 
requiring the primary identity. 

Unknown 
module action 

Controls the action taken when an unknown module is connected to the 
system. Possible actions are Do Nothing, or Show a Fault (error code 
20:2, see "Error Codes" section within this document for details). 

Module check 
hold off time 

Controls the time which will be waited by the PVSG on startup before 
checking for modules on the system. 

Concurrency 
policy 

Controls the number of software update operations which may happen 
simultaneously. Options are limiting concurrency to one simultaneous 
operation, or one simultaneous operation per CAN bus. 
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5.4.9.6. Custom Programming Plugins 

The Custom Programming Plugin manager allows the user to add a custom programming 

plugins, built specifically to run on the PVSG. Consult document 1051G05, Custom Logic 

User Guide or contact Parker for more information on custom programming plugins. 

5.4.10. User Accounts 

5.4.10.1. User Account Management 

User accounts can be managed via the User Account Management section. If user 

management is configured, certain operations can be restricted to specific users. If user 

management is not configured (i.e. there are no users present), all available end-user 

operations are possible via the anonymous user, which is logged in by default. Add a new 

user by clicking the Add button. 
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Basic user properties may be configured, in addition to the authentication mechanism and 

accessible features. Possible authentication mechanisms are listed below: 

Authentication 
Mechanism Description 

Password A username and password combination is required to log in as this user. 
The padlock icon at the end of the password field indicates the strength of 
the password; to be considered secure, a password should contain at 
least 5 characters including upper case and lower case letters, one 
number and one symbol. "Weak" passwords may still be used at the 
discretion of the user. 

Available permissions, and their meaning, are listed below: 

Permission Description 

Erase Fault Logs Controls whether or not the fault logs may be erased by this user. 

Read Configuration Controls whether or not the configuration may be read by this user. 

Write Configuration Controls whether or not the configuration may be written by this user. 

Available users are listed within the main User Account Management applet: 

 

A specific user may be edited or deleted using the buttons within the user information: 

 

5.4.11. Logging 

5.4.11.1. Fault Logging 

Fault logging configuration relates to specific J1939 Diagnostic Trouble Codes (DTCs) 

contained within J1939 DM1 messages which should be logged to non-volatile memory 

within the PVSG. 
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Specific faults are configured in terms of Suspect Parameter Number (SPN), Failure Mode 

Index (FMI) and the J1939 source address and CAN bus of the originating module. A 

customer specific "code" can optionally be specified (which is logged with the fault 

information). Note that the description field is for configuration management purposes only 

and is not logged with the fault data. The debounce time relates to the minimum time period 

for which a fault must be seen to be inactive before another occurrence of the fault will be 

logged. This helps to prevent multiple faults from being logged for a single fault event. Note 

that the minimum debounce time is 2.5 seconds, which is required due to the period of the 

J1939 DM1 message. 
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The action taken when the fault log becomes full (per storage limits, see "Storage 

Administrator" section) can be set within the Settings group. The following actions are 

available. 

Action Description 

Stop Logging Faults will no longer be logged until the fault log is manually cleared via 
the dashboard. 

Overwrite Oldest 
Logs 

Each time a new fault instance is required to be logged, the oldest fault 
log at that time will be erased. 

Optionally, metadata may be logged with each fault. Currently available metadata types are 

listed below. 

Metadata Description 

Engine 
Hours 

The current running hours of the engine. Obtained via J1939 PGN 0xFEE5. The 
PVSG can optionally request this information (via the J1939 RQST message) if 
required. If request is enabled, the information will be queried at an interval of 5 
seconds. 

5.4.12. Custom Applications 

The Custom Application Manager allows the user to add a custom application, built 

specifically to run on the PVSG. Consult document 1051G05, Custom Logic User Guide for 

more details or contact Parker for more information on custom applications. 
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5.4.13. Storage Administrator 

The Storage Administrator allows the user to configure how the 'data log' memory on the 

PVSG is used by various features. Each feature which requires storage space on the data log 

memory is allocated a percentage of the available space. The per-feature allocation is 

adjusted using the control sliders. Note that some elements are set as 'read only' to indicate 

that these features require space though the user cannot control them. 

 

The system sets recommended defaults for new configurations. In the allocation summary, an 

approximate translation of percentage storage allocation to feature specific units is given, 

though it should be noted that this translation is approximate. 

Note that storage allocation limits are approximate and subject to a certain amount of error. 

The PVSG platform software will do its best to achieve the desired limits, however a certain 

degree of variance is expected. 

5.4.14. Configuration Management 

It is recommended to use the Version Information section under the Configuration 

Management menu to properly version control your configuration files. This allows both a 

3-component version number to be attached to your configuration as well as a label of your 

choosing. It is recommended to increment the version number upon configuration changes 

according to your local version control scheme. The information inputted here will be shown 

in the PVSG dashboard window under the Target Info section: 
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5.4.15. Exporting Configurations 

A configuration report can be generated in HTML format via the File > Export > Report 

menu. Any modern web browser should be capable of viewing the report. 

5.4.16. Transferring Configurations 

The active configuration can be transferred to the target directly from the tool. With the target 

connected (LED status shows connected to USB, Ethernet or Wireless and dashboard reports 

connected), select Target > Send Configuration to start the process. Note that the process 

will require the target to be rebooted before the new configuration takes effect. In addition, 

after rebooting, there may be a delay until the target reports it is back online (LED status 

reports "Waiting" or "Connected") as it performs any necessary internal reconfiguration steps 

(LED status will report "Init" while reconfiguring). 

The configuration from a currently connected PVSG can be read using the Target > Read 

Configuration menu. Note if the configuration is password protected (see the "Configuration 

Security" section of this document for details on how to password protect a configuration), 

you will be prompted for this during the read procedure. Also note that if you have not reset 

the PVSG (either manually or via prompt from configuration tool) after transferring a 

configuration, the retrieved configuration is the new configuration, not the currently active 

configuration. 

5.4.16.1. Configuration Security 

If user management has been configured (see "User Account Management" section) on the 

configuration already installed on the PVSG, attempting to read or write the configuration 

will result in a request for authentication if the currently logged in user does not have 

permission to read/write the configuration respectively. Note that the need for user 

authentication is based on the configuration already installed on the PVSG, and not the 

configuration loaded into the configuration tool. If authentication is required, the following 

window will appear: 



   

VA 1051000 | Parker Vehicle System Gateway  Page 74 of 100 
 © 2016-2019 Parker Hannifin Canada.  All Rights Reserved  

 

To continue, enter the username and password of a user who has permission to perform the 

respective operation (either read configuration or write configuration). 

Configuration Overwrite 

The option labelled Force Configuration Overwrite on the Build Combined Target Package 

window allows control over whether the configuration already installed on the target is 

overwritten. If selected, the combined configuration will always be deployed to the target and 

will overwrite any installed configuration. If not selected, the combined configuration will 

only be written to the target if no configuration is already present. 

5.4.17. Configuration Security 

A configuration can be protected with one or more passwords to provide security. Separate 

passwords for 'view' and 'edit' can be set. This can be done via the Edit > Passwords menu. 



   

Page 75 of 100  VA 1051000 | Parker Vehicle System Gateway 
 © 2016-2019 Parker Hannifin Canada.  All Rights Reserved.  

 

Passwords are operated in a hierarchical manner; that is if the user has the 'edit' password, 

then they can of course 'view' the configuration as well. 

Note that the resultant granted permission is taken as a combination of the password (if one is 

required) provided and the tool license you have. For example, if you provide the 'edit' 

password but do not have 'edit' abilities enabled in your license, then you still cannot edit the 

configuration. 

5.4.18. Tool Information 

Version information for the configuration tool can be sought using the Help > About menu. 

5.4.19. Command Line Interface 

The configuration tool also provides a command line interface. Locate pvsgcfg.exe (installed 

as part of the installer 1051605), and run "pvsgcfg.exe -h" to get a listing of all of the 

available commands. 
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6. Recovery 

In the event a PVSG is corrupted or embedded software upgrade has failed, attempt recovery 

via: 

1. run update tool (1051606), 

2. (if previous step did not work) activate hardware recovery mechanism (see "Connector 

Pinout" section of this document for "Recovery" pin, active high), power cycle the 

PVSG to enter bootstrap mode (see Note below), and redo 1. 

 Note: The first time a PVSG is connected to a PC via USB with the "Recovery" pin 

active, Windows will initiate a USB Driver Software installation. The PVSG PC 

Software should not be used until the USB Driver Software installation has 

completed. 

 Note: update tool status will show BOOT MODE to indicate hardware recovery 

mechanism has been activated correctly: 
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7. Known Limitations 

Component Case Description Workaround 

USB 30575 USB interface is not isolated. This 
can result in damage to the PVSG 
or a PC when the PC is powered 
off of the Mains (as opposed to 
powered by a battery alone). 

This is a known limitation that was 
decided upon at design time and 
will not be changed. 

Use of a USB isolator is 
recommended to reduce the risk 
of damage to the PVSG or other 
equipment, when connecting to 
the PVSG from a USB host port 
on a PC connected to Mains 
supply. 

PVSG 
Software 

41399 The PVSG currently utilises an 
internal system clock whereby the 
maximum encodable time is 
03:14:07 19 January 2038.  

It is expected that a workaround 
will be available in a future 
software update. 

PVSG 
Software 

35254 PVSG message routing operates 
according to a FIFO algorithm 
whereby messages are 
dispatched in the same order as 
they are received. 

None. 

PVSG 
Software 

45300 Serialisation error when using 
trying to save configuration files 
created with 1051605 V0.14.x.x 
when using 1051605 V0.15.x.x or 
newer. 

Goto System Modules > Module 
Management Settings and 
select something from each of the 
drop down boxes. 

PVSG 
Hardware 

47460 There is a known issue with 
wireless channel 6 where the 
connections can be unexpectedly 
dropped. 

Avoid using channel 6. 

PVSG 
Software 

46924 With J1939 management and 
wakeup enabled on the same 
CAN bus, once awake, the PVSG 
will not go sleep due to the 
periodic J1939 DM1 message 
sent by the PVSG keeping the 
CAN bus active. 

Avoid using J1939 management 
and wakeup on the same CAN 
bus if wake to sleep transition is 
required. 

PVSG 
Software 

51900 System and Fault log databases 
can become corrupt if the server 
is not properly shutdown before 
removing power from the PVSG. 

Always use a wake up to initiate a 
server shutdown before powering 
off the PVSG. 

https://ecd.manuscript.com/default.asp?30575
https://ecd.manuscript.com/default.asp?41399
https://ecd.manuscript.com/default.asp?35254
https://ecd.manuscript.com/default.asp?45300
https://ecd.manuscript.com/default.asp?47460
https://ecd.manuscript.com/f/cases/46924/Test-1051M06-T371-PASS
https://ecd.manuscript.com/f/cases/51900/Unable-to-retreive-PVSG-System-Log
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8. Software Release Notes 

This section provides software release notes for the distributed PVSG software components 

referenced by this document. 

Each section below provides a summary of the software released that corresponds to a release 

of this document. For each software item listed the following is provided: 

• Part Number: Parker internal software part number 

• Software Version: Software version reported by the software 

• Config Format: Internal configuration format. Configuration created with one software 

version should be compatible with another software version that uses the same 

configuration format. In general, configuration created with software that is one 

configuration format older, can be opened and saved using the current configuration 

format. 

• Plugin SDK Version: Internal plugin SDK version. Used to indicated compatibility with 

custom logic (custom application or custom programming protocol plugin) created with 

10516C2 & 10516C3. 

• Release Case: Parker internal case number associated with a software release 

8.1. 1051G02.31 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

• 1051007R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.31.194.194 19 Not 
Applicable 

Case 
55044 

Embedded Software 
Deployment Package 

1051642 v0.27.362 19 2 Case 
53953 

Summary of changes from 1051G02.30: 

• PVSG Dashboard Window Behavior has changed (Case 53316): 

o The dashboard will open maximized if the argument --open-maximized is used when 

opening pvsgtray.exe. 

https://ecd.manuscript.com/default.asp?W636
http://ecd026a16:8080/job/1051605/194/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?55044
http://ecd026a16:8080/job/1051642/322/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?53953
https://ecd.manuscript.com/default.asp?53316
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o The dashboard now has a maximize button on the top right. 

o The dashboard now minimizes to taskbar and not the system tray. 

o The dashboard is now in the list of applications when alt-tab is used. 

8.2. 1051G02.30 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

• 1051007R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.30.190.190 19 Not 
Applicable 

Case 
55003 

Embedded Software 
Deployment Package 

1051642 v0.27.362 19 2 Case 
53953 

Summary of changes from 1051G02.29: 

• PVSG is now added to the end of the RP1210 APIImplementations string during fresh 

install, matching RP1210 spec (Case 55000). 

8.3. 1051G02.29 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

• 1051007R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 1051605 v0.29.186.186 19 Not Case 

http://ecd026a16:8080/job/1051605/190/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?55003
http://ecd026a16:8080/job/1051642/322/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?53953
https://ecd.manuscript.com/default.asp?55000
http://ecd026a16:8080/job/1051605/186/artifact/pvsg-setup.exe
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Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

Installer Applicable 53952 

Embedded Software 
Deployment Package 

1051642 v0.27.362 19 2 Case 
53953 

Summary of changes from 1051G02.28: 

• Resolved more issues with J1939 large messages using the embedded J1939 stack. (case 

53641) 

8.4. 1051G02.28 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

• 1051007R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.28.185.185 19 Not 
Applicable 

Case 
53328 

Embedded Software 
Deployment Package 

1051642 v0.26.361 19 2 Case 
53284 

Summary of changes from 1051G02.27: 

• Resolved issue with system module programming in which timeouts deem a 

programming operation a success. (case 53242) 

• Resolved issues with J1939 large messages using the embedded J1939 stack. (case 53264) 

8.5. 1051G02.27 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

https://ecd.manuscript.com/default.asp?53952
http://ecd026a16:8080/job/1051642/322/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?53953
https://ecd.manuscript.com/f/cases/53641/
http://ecd026a16:8080/job/1051605/185/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?53328
http://ecd026a16:8080/job/1051642/321/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?53284
https://ecd.manuscript.com/f/cases/53242/Various-Flash-Loader-plugins-do-not-report-failures-correctly
https://ecd.manuscript.com/f/cases/53264/
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• 1051007R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.27.183.183 19 Not 
Applicable 

Case 
52948 

Embedded Software 
Deployment Package 

1051642 v0.25.355 19 2 Case 
51749 

Summary of changes from 1051G02.26: 

• Resolved issue with tool licensing in which removable storage devices caused license 

validation to fail. (case 52417) 

• Resolved PVSG driver service crash when PVSG is used as a DLA. (case 52124) 

8.6. 1051G02.26 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

• 1051007R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.26.178.178 19 Not 
Applicable 

Case 
52270 

Embedded Software 
Deployment Package 

1051642 v0.25.355 19 2 Case 
51749 

Summary of changes from 1051G02.25: 

• Updated variant manager to match 1051002 variant in 1051F79.02A. (Case 51924) 

• Updated variant manager to match requirements for 1051005, 1051006 and 1051007. 

(Case 50943) 

8.7. 1051G02.25 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

http://ecd026a16:8080/job/1051605/183/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?52948
http://ecd026a16:8080/job/1051642/315/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?51749
https://ecd.manuscript.com/f/cases/52417/
https://ecd.manuscript.com/f/cases/52124/
http://ecd026a16:8080/job/1051605/178/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?52270
http://ecd026a16:8080/job/1051642/315/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?51749
https://ecd.manuscript.com/f/cases/51924/Satisfy-1051F79-02A
https://ecd.manuscript.com/f/cases/50943/Support-New-Variants
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• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.25.173.173 19 Not 
Applicable 

Case 
51750 

Embedded Software 
Deployment Package 

1051642 v0.25.355 19 2 Case 
51749 

Summary of changes from 1051G02.24: 

• Resolved issue with Plugin SDK asynchronous threads persisting longer than intended. 

(case 50974) 

8.8. 1051G02.24 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.24.171.171 19 Not 
Applicable 

Case 
50832 

Embedded Software 
Deployment Package 

1051642 v0.24.351 19 2 Case 
50834 

Summary of changes from 1051G02.23: 

• Resolved issue with Plugin SDK (TaskScheduleAt()). (case 50127) 

• Resolved issue with Ethernet. (case 51048) 

8.9. 1051G02.23 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

http://ecd026a16:8080/job/1051605/173/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?51750
http://ecd026a16:8080/job/1051642/315/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?51749
https://ecd.manuscript.com/default.asp?50974
http://ecd026a16:8080/job/1051605/171/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?50832
http://ecd026a16:8080/job/1051642/312/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?50834
https://ecd.manuscript.com/f/cases/50127/Custom-apps-SDK-TaskScheduleAt-scheduled-time-is-delayed
https://ecd.manuscript.com/f/cases/51048/PVSG-Sprint23-Ethernet-Issue
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• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.23.169.169 19 Not 
Applicable 

Case 
49806 

Embedded Software 
Deployment Package 

1051642 v0.23.341 19 2 Case 
49808 

Summary of changes from 1051G02.22: 

• General improvements and bug fixes to custom logic (including custom applications and 

custom programming plugins). (Case 50151, 50152, 50153) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.10. 1051G02.22 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 v0.22.165.165 19 Not 
Applicable 

Case 
49273 

Embedded Software 
Deployment Package 

1051642 v0.22.331 19 2 Case 
49271 

Summary of changes from 1051G02.21: 

• General improvements and bug fixes to custom logic (including custom applications and 

custom programming plugins). (Case 48989) 

• Added custom logic related error codes (21:1 to 21:5). (case 49743) 

• Enhanced support for variants 1051005R00 and 1051006R00. (Case 49796) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

http://ecd026a16:8080/job/1051605/169/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?49806
http://ecd026a16:8080/job/1051642/301/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?49808
https://ecd.manuscript.com/default.asp?50151
https://ecd.manuscript.com/default.asp?50152
https://ecd.manuscript.com/default.asp?50153
http://ecd026a16:8080/job/1051605/165/artifact/pvsg-setup.exe
https://ecd.manuscript.com/f/cases/49273/
http://ecd026a16:8080/job/1051642/288/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/f/cases/49271/
https://ecd.manuscript.com/default.asp?48989
https://ecd.manuscript.com/default.asp?49743
https://ecd.manuscript.com/f/cases/49796/Add-support-for-switching-between-RS9113-and-RS9116-radios-to-platform
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8.11. 1051G02.21 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

• 1051005R00 

• 1051006R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Plugin SDK 
Version 

Release 
Case 

PC Software Suite 
Installer 

1051605 0.21.159.159 19 Not 
Applicable 

Case 
48813 

Embedded Software 
Deployment Package 

1051642 0.21.299 19 2 Case 
48815 

Summary of changes from 1051G02.20: 

• More support for custom applications. (Case 48730) 

• Added preliminary support for custom programming plugins. (Case 48991) 

• The version of the installed PVSG PC Software (1051605) can be obtained from the 

dashboard. (Case 49282) 

• Added preliminary support for variants 1051005R00 and 1051006R00. (Case 48649) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.12. 1051G02.20 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.20.149.149 18 Case 47957 

Embedded Software 
Deployment Package 

1051642 0.20.280 18 Case 47956 

Summary of changes from 1051G02.19: 

http://ecd026a16:8080/job/1051605/159/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?48813
http://ecd026a16:8080/job/1051642/264/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?48815
https://ecd.manuscript.com/default.asp?48730
https://ecd.manuscript.com/default.asp?48991
https://ecd.manuscript.com/default.asp?49282
https://ecd.manuscript.com/f/cases/48649/Investigate-impact-of-1051120-00A-on-1051642
http://ecd026a16:8080/job/1051605/149/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?47957
http://ecd026a16:8080/job/1051642/280/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?47956
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• Resolved an issue with establishing a secure session with a connected PVSG. (Case 

48919) 

• Wake On CAN Timeout was modified to a general purpose timeout for all wakeup 

sources. (Case 47680) 

• DM1 messages sent by the PVSG server are now sent to connected RP1210 clients. (Case 

48011) 

• Added preliminary support for custom applications. (Case 47964) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.13. 1051G02.19 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.19.140.140 17 Case 47346 

Embedded Software 
Deployment Package 

1051642 0.19.261 17 Case 47345 

Summary of changes from 1051G02.18: 

• User login operations are now logged in the system log. (Case 47560) 

• Source bus and address are now logged in the fault log. (Case 47538) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.14. 1051G02.18 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.18.127.127 17 Case 46875 

Embedded Software 1051642 0.18.254 17 Case 46876 

https://ecd.manuscript.com/default.asp?48919
https://ecd.manuscript.com/f/cases/47680/
https://ecd.manuscript.com/f/cases/48011/
https://ecd.manuscript.com/default.asp?47964
http://ecd026a16:8080/job/1051605/140/artifact/pvsg-setup.exe
https://ecd.manuscript.com/f/cases/47346/Release-1051605-V0-19-x-y-PC-Driver-Suite-Installer
http://ecd026a16:8080/job/1051642/236/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/f/cases/47345/Release-1051642-V0-19-z-PVSG-Deployment-Package
https://ecd.manuscript.com/default.asp?47560
https://ecd.manuscript.com/default.asp?47538
http://ecd026a16:8080/job/1051605/127/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?46875
http://ecd026a16:8080/job/1051642/227/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?46876
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Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

Deployment Package 

Summary of changes from 1051G02.17: 

• Added support for features enabled by license. (case 31668) 

• File extension .pvsgx no longer supported. (Case 46768) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.15. 1051G02.17 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

• 1051004R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.17.111.111 16 Case 46178 

Embedded Software 
Deployment Package 

1051642 0.17.230 16 Case 46177 

Summary of changes from 1051G02.16: 

• Configuration read/write operations can be restricted via user management. (Case 45917) 

• Storage control mechanism added to allow user control of how the data log memory is 

used. (Case 46280) 

• Added preliminary support for sleep mode 2. (Case 46213) 

• J1708 software support requires hardware modifications captured in case 46240, which 

are available in PVSG 1051004. (case 46242) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.16. 1051G02.16 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

https://ecd.manuscript.com/default.asp?31668
https://ecd.manuscript.com/default.asp?46768
http://ecd026a16:8080/job/1051605/111/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?46178
http://ecd026a16:8080/job/1051642/204/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?46177
https://ecd.manuscript.com/default.asp?45917
https://ecd.manuscript.com/default.asp?46280
https://ecd.manuscript.com/default.asp?46213
https://ecd.manuscript.com/default.asp?46240
https://ecd.manuscript.com/default.asp?46242
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Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.16.97.97 14 Case 45418 

Embedded Software 
Deployment Package 

1051642 0.16.202 14 Case 45417 

Summary of changes from 1051G02.15: 

• Added fault logging. (Case 45432) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.17. 1051G02.15 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.15.86.86 11 Case 44865 

Embedded Software 
Deployment Package 

1051642 0.15.177 11 Case 44864 

Summary of changes from 1051G02.14: 

• J1708 messages sent from the PVSG are echo'd back to the RP1210 client. (Case 44400) 

• System modules using the Vansco Flashload over CAN protocol can now be updated by 

the PVSG (prototype only). (Case 44872) 

• Alternate identities for system modules are now supported. (Case 44918) 

• Missing and unknown system modules are now handled. (Case 44923) 

• System software update/repreogramming operations are now logged in the system log. 

(Case 44913) 

• System module configuration is now part of the HTML export report. (Case 44832) 

• System modules can now be configured as optional. (Case 45149) 

• System module identities can now be compared to determine whether a module matches 

the expected configuration or not. (Case 44197) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.18. 1051G02.14 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

http://ecd026a16:8080/job/1051605/97/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?45418
http://ecd026a16:8080/job/1051642/179/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?45417
https://ecd.manuscript.com/default.asp?45432
http://ecd026a16:8080/job/1051605/86/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?44865
http://ecd026a16:8080/job/1051642/159/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?44864
https://ecd.manuscript.com/default.asp?44400
https://ecd.manuscript.com/default.asp?44872
https://ecd.manuscript.com/default.asp?44918
https://ecd.manuscript.com/default.asp?44923
https://ecd.manuscript.com/default.asp?44913
https://ecd.manuscript.com/default.asp?44832
https://ecd.manuscript.com/default.asp?45149
https://ecd.manuscript.com/default.asp?44197
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• 1051002R00, 1051002R01 

• 1051003R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.14.73.73 10 Case 44219 

Embedded Software 
Deployment Package 

1051642 0.14.160 10 Case 44217 

Summary of changes from 1051G02.13: 

• Configuration tool enhanced to accept a list of known modules and associated software 

archive(s). (Case 44345) 

• J1708 support via RP1210. (Case 44343) 

• J1708 connected status available on status LED. (Case 44368) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.19. 1051G02.13 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.13.59.59 9 Case 43589 

Embedded Software 
Deployment Package 

1051642 0.13.143 9 Case 43588 

Summary of changes from 1051G02.12: 

• System mapping (J1939-based) added to dashboard. (Case 43586) 

• CAN metrics added to dashboard. (Case 44195) 

• Misc GUI enhancements including support for user configurable themes. (Case 44195) 

• Added option to configure J1939 TP BAM inter-packet message spacing. (Case 40205) 

• Preliminary J1708 support via RP1210. (Case 43572, 43599) 

• Other miscellaneous software enhancements. (see cases linked to release cases) 

8.20. 1051G02.12 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

http://ecd026a16:8080/job/1051605/73/artifact/pvsg-setup.exe
https://ecd.manuscript.com/default.asp?44219
http://ecd026a16:8080/job/1051642/145/artifact/pvsg-targetinstall-protected-nosec-nodelocked.pvsgs
https://ecd.manuscript.com/default.asp?44217
https://ecd.manuscript.com/default.asp?44345
https://ecd.manuscript.com/default.asp?44343
https://ecd.manuscript.com/default.asp?44368
https://ecd.manuscript.com/default.asp?43589
https://ecd.manuscript.com/default.asp?43588
https://ecd.manuscript.com/default.asp?43586
https://ecd.manuscript.com/default.asp?44195
https://ecd.manuscript.com/default.asp?44195
https://ecd.manuscript.com/default.asp?40205
https://ecd.manuscript.com/default.asp?43572
https://ecd.manuscript.com/default.asp?43599
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• 1051002R00, 1051002R01 

• 1051003R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.12.41.41 9 Case 42427 

Embedded Software 
Deployment Package 

1051642 0.12.107 9 Case 42426 

Summary of changes from 1051G02.11: 

• Resolved issue with unexpected "Driver connection aborted" when connected to Parker 

VMM Software. (Case 42273) 

• Resolved issue that prevented some users from accessing licensed features of the 

Configuration Tool. (Case 42475) 

• Other miscellaneous software enhancements (see cases linked to release cases) 

8.21. 1051G02.11 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG) 

• 1051001R00, 1051001R01 

• 1051002R00, 1051002R01 

• 1051003R00 

with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.11.38.38 8 Case 41680 

Embedded Software 
Deployment Package 

1051642 0.11.103 8 Case 41681 

Summary of changes from 1051G02.10: 

• Corrected issue with routing to disconnected CAN port causing CAN routing on other 

ports to fail. (Case 41852) 

• Added support for RP1210 clients connected to PVSG receiving messages sent by PVSG. 

(Case 32506, 42138) 

• Configuration tool enhancements. (Case 41520, 38942, 42476, 40943, 41205, 41504) 

o Support for variants 1051001R01, 1051002R02 and 1051003R00 added. (Case 

42324, 42341) 

• Update tool enhancements. (Case 41283) 

• Miscellaneous PC software enhancements (Case 41648, 40866, 41829, 41929) 

• Miscellaneous embedded software enhancements (Case 37613, 38936, 41257, 41410, 

42229, 41847, 41857, 42060, 42446, 42170, 42137) 

https://ecd.manuscript.com/default.asp?42427
https://ecd.manuscript.com/default.asp?42426
https://ecd.manuscript.com/default.asp?42273
https://ecd.manuscript.com/default.asp?42475
https://ecd.manuscript.com/default.asp?41680
https://ecd.manuscript.com/default.asp?41681
https://ecd.manuscript.com/default.asp?41852
https://ecd.manuscript.com/default.asp?32506
https://ecd.manuscript.com/default.asp?42138
https://ecd.manuscript.com/default.asp?41520
https://ecd.manuscript.com/default.asp?38942
https://ecd.manuscript.com/default.asp?42476
https://ecd.manuscript.com/default.asp?40943
https://ecd.manuscript.com/default.asp?41205
https://ecd.manuscript.com/default.asp?41504
https://ecd.manuscript.com/default.asp?42324
https://ecd.manuscript.com/default.asp?42341
https://ecd.manuscript.com/default.asp?41283
https://ecd.manuscript.com/default.asp?41648
https://ecd.manuscript.com/default.asp?40866
https://ecd.manuscript.com/default.asp?41829
https://ecd.manuscript.com/default.asp?41929
https://ecd.manuscript.com/default.asp?37613
https://ecd.manuscript.com/default.asp?38936
https://ecd.manuscript.com/default.asp?41257
https://ecd.manuscript.com/default.asp?41410
https://ecd.manuscript.com/default.asp?42229
https://ecd.manuscript.com/default.asp?41847
https://ecd.manuscript.com/default.asp?41857
https://ecd.manuscript.com/default.asp?42060
https://ecd.manuscript.com/default.asp?42446
https://ecd.manuscript.com/default.asp?42170
https://ecd.manuscript.com/default.asp?42137
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8.22. 1051G02.10 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), 1051001R00 & 1051002R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.10.34.34 8 Case 41102 

Embedded Software 
Deployment Package 

1051642 0.10.77 8 Case 41101 

Summary of changes from 1051G02.09: 

• Added periodic transmission of J1939 DM1 to report PVSG status. (Case 41785) 

• PVSG startup time shortened. (Case 41239) 

• Dashboard enhancements. (Case 40981, 41854) 

• Configuration tool enhancements. (Case 41435, 41525, 41411) 

• Update tool enhancements. (Case 41412, 41283) 

8.23. 1051G02.09 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), 1051001R00 & 1051002R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.9.32.32 8 Case 40813 

Embedded Software 
Deployment Package 

1051642 0.9.41 8 Case 40812 

Summary of changes from 1051G02.08: 

• Dashboard enhancements: 

o Resolved issue of unexpected error being reported in Dashboard (Case 40876) 

o Resolved issue of unexpected critical/warning entry in system log (Case 40875) 

o Decoupled system log detail text from database to allow supporting different 

language requirements in the future (Case 40894) 

• Configuration tool enhancements: 

o Added time and date interface to configure PVSG RTC and supporting cases (Case 

40873, 40604, 41400, 41401) 

o Destination address is used when routing PDU1 messages (Case 40509) 

o Miscellaneous enhancements (Case 37209, 41388, 37214, 41043, 40213, 39115) 

• Update tool enhancements. (Case 38656, 37182) 

• USB enhancements and supporting cases: (Case 40925, 41274, 41277, 41193) 

https://ecd.manuscript.com/default.asp?41102
https://ecd.manuscript.com/default.asp?41101
https://ecd.manuscript.com/default.asp?41785
https://ecd.manuscript.com/default.asp?41239
https://ecd.manuscript.com/default.asp?40981
https://ecd.manuscript.com/default.asp?41854
https://ecd.manuscript.com/default.asp?41435
https://ecd.manuscript.com/default.asp?41525
https://ecd.manuscript.com/default.asp?41411
https://ecd.manuscript.com/default.asp?41412
https://ecd.manuscript.com/default.asp?41283
https://ecd.manuscript.com/default.asp?40813
https://ecd.manuscript.com/default.asp?40812
https://ecd.manuscript.com/default.asp?40876
https://ecd.manuscript.com/default.asp?40875
https://ecd.manuscript.com/default.asp?40894
https://ecd.manuscript.com/default.asp?40873
https://ecd.manuscript.com/default.asp?40604
https://ecd.manuscript.com/default.asp?41400
https://ecd.manuscript.com/default.asp?41401
https://ecd.manuscript.com/default.asp?40509
https://ecd.manuscript.com/default.asp?37209
https://ecd.manuscript.com/default.asp?41388
https://ecd.manuscript.com/default.asp?37214
https://ecd.manuscript.com/default.asp?41043
https://ecd.manuscript.com/default.asp?40213
https://ecd.manuscript.com/default.asp?39115
https://ecd.manuscript.com/default.asp?38656
https://ecd.manuscript.com/default.asp?37182
https://ecd.manuscript.com/default.asp?40925
https://ecd.manuscript.com/default.asp?41274
https://ecd.manuscript.com/default.asp?41277
https://ecd.manuscript.com/default.asp?41193
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8.24. 1051G02.08 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), 1051001R00 & 1051002R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.8.29.29 7 Case 40037 

Embedded Software 
Deployment Package 

1051642 0.8.37 7 Case 40036 

Summary of changes from 1051G02.07: 

• Dashboard enhancements: 

o Added logs interface to retrieve system logs. (Case 39997) 

o Added support for displaying more than one active server error code. (Case 40239) 

• Configuration tool enhancements: 

o Miscellaneous enhancements. (Case 39093, 38588) 

8.25. 1051G02.07 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), 1051001R00 & 1051002R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.7.27.27 7 Case 39155 

Embedded Software 
Deployment Package 

1051642 0.7.35 7 Case 39154 

Summary of changes from 1051G02.06: 

• Configuration tool enhancements: 

o Command line interface added to support sending a configuration file to the PVSG. 

(Case 38627) 

o Other miscellaneous enhancements. (Case 38622, 39290, 39304, 37866, 39368, 39456, 

39457, 40165, 40160) 

• Update tool enhancements: 

o Retry counter visible in bottom right corner of update tool. (Case 39289) 

• Dashboard enhancements. (Case 39071, 39190) 

• New error codes: 2:4, 2:5, 2:6 and 2:7. (Case 39863) 

• Corrected issue that resulted in router based error codes (1:x) being off by one in the 

dashboard. (Case 39426) 

8.26. 1051G02.06 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), 1051001R00 & 1051002R00 with the following software: 

https://ecd.manuscript.com/default.asp?40037
https://ecd.manuscript.com/default.asp?40036
https://ecd.manuscript.com/default.asp?39997
https://ecd.manuscript.com/default.asp?40239
https://ecd.manuscript.com/default.asp?39093
https://ecd.manuscript.com/default.asp?38588
https://ecd.manuscript.com/default.asp?39155
https://ecd.manuscript.com/default.asp?39154
https://ecd.manuscript.com/default.asp?38627
https://ecd.manuscript.com/default.asp?38622
https://ecd.manuscript.com/default.asp?39290
https://ecd.manuscript.com/default.asp?39304
https://ecd.manuscript.com/default.asp?37866
https://ecd.manuscript.com/default.asp?39368
https://ecd.manuscript.com/default.asp?39456
https://ecd.manuscript.com/default.asp?39457
https://ecd.manuscript.com/default.asp?40165
https://ecd.manuscript.com/default.asp?40160
https://ecd.manuscript.com/default.asp?39289
https://ecd.manuscript.com/default.asp?39071
https://ecd.manuscript.com/default.asp?39190
https://ecd.manuscript.com/default.asp?39863
https://ecd.manuscript.com/default.asp?39426
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Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.6.25.25 (*) 6 Case 38547 

Embedded Software 
Deployment Package 

1051642 0.6.33 6 Case 38546 

* NOTE: The version of the update tool distributed with this release is not able to install older 

versions of 1051642. 

Summary of changes from 1051G02.05: 

• Configuration tool enhancements: 

o Delete key supported as a means to remove message filter entries. (Case 38575) 

o Resolve issues related to message filter entries. (Case 38582, 38532) 

o All configuration changes require reboot before taking effect. (Case 36679, 38591) 

o Other miscellaneous enhancements. (Case 37984, 38319) 

• Update tool enhancements: 

o Only one instance of the tool can be opened. (Case 38689) 

o Other miscellaneous enhancements. (Case 38599, 39095, 39118, 39308) 

• Dashboard enhancements. (Case 39042, 38551) 

• Installer registers PVSG file extensions with Windows to link them to the appropriate 

PVSG tool. (Case 36599) 

• Ethernet and wireless enhancements. (Case 38342, 38361, 38907, 39111, 39291, 39292, 

38664, 38665) 

• Status LED enhancements: 

o Ethernet and wireless status. (Case 38345) 

o CAN bus off & error passive status. (Case 38390) 

8.27. 1051G02.05 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), PRO1051001R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.5.21.21 5 Case 37722 

Embedded Software 
Deployment Package 

1051642 0.5.28 5 Case 37721 

Summary of changes from 1051G02.04: 

• Wake on CAN supported. (Case 37699, 38126) 

• Configuration tool now supports PVSG variants. (Case 38132) 

• Configuration tool notifies user when configuration file contains unsaved changes. (Case 

37984) 

• Configuration tool now supports keyboard shortcuts. (Case 37983) 

• Configuration tool now supports a command line interface. (Case 37642) 

https://ecd.manuscript.com/default.asp?38547
https://ecd.manuscript.com/default.asp?38546
https://ecd.manuscript.com/default.asp?38575
https://ecd.manuscript.com/default.asp?38582
https://ecd.manuscript.com/default.asp?38532
https://ecd.manuscript.com/default.asp?36679
https://ecd.manuscript.com/default.asp?38591
https://ecd.manuscript.com/default.asp?37984
https://ecd.manuscript.com/default.asp?38319
https://ecd.manuscript.com/default.asp?38689
https://ecd.manuscript.com/default.asp?38599
https://ecd.manuscript.com/default.asp?39095
https://ecd.manuscript.com/default.asp?39118
https://ecd.manuscript.com/default.asp?39308
https://ecd.manuscript.com/default.asp?39042
https://ecd.manuscript.com/default.asp?38551
https://ecd.manuscript.com/default.asp?36599
https://ecd.manuscript.com/default.asp?38342
https://ecd.manuscript.com/default.asp?38361
https://ecd.manuscript.com/default.asp?38907
https://ecd.manuscript.com/default.asp?39111
https://ecd.manuscript.com/default.asp?39291
https://ecd.manuscript.com/default.asp?39292
https://ecd.manuscript.com/default.asp?38664
https://ecd.manuscript.com/default.asp?38665
https://ecd.manuscript.com/default.asp?38345
https://ecd.manuscript.com/default.asp?38390
https://ecd.manuscript.com/default.asp?37722
https://ecd.manuscript.com/default.asp?37721
https://ecd.manuscript.com/default.asp?36509
https://ecd.manuscript.com/default.asp?38126
https://ecd.manuscript.com/default.asp?38132
https://ecd.manuscript.com/default.asp?37984
https://ecd.manuscript.com/default.asp?37983
https://ecd.manuscript.com/default.asp?37642
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• J1939 Software Identification (SOFT) message now includes configuration label in 

addition to version and file name information. (Case 37220) 

• Preliminary Ethernet and wireless support. (Case 37976) 

8.28. 1051G02.04 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), PRO1051001R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.4.17.17 2 Case 37190 

Embedded Software 
Deployment Package 

1051642 0.4.24 2 Case 37189 

Summary of changes from 1051G02.03: 

• The configuration tool now requires a license in order to view/edit a configuration. 

Configurations now support password protection for view/edit ability. (case 36794) 

• The configuration tool can now generate a report which can be viewed without the 

configuration tool. (case 36811) 

• The configuration tool can read configuration directly from the PVSG. (Case 36796) 

• The dashboard replicates the error information available from the Status LED. (Case 

37191) 

• Added status LED error code 1:4. (Case 37549) 

• Configurable wakeup sources are now supported. (Case 36509) 

8.29. 1051G02.03 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), PRO1051001R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Config 
Format 

Release 
Case 

PC Software Suite Installer 1051605 0.3.14.14 1 Case 36503 

Embedded Software 
Deployment Package 

1051642 0.3.18 1 Case 36501 

Summary of changes from 1051G02.02: 

• Added status LED error codes 1:3, 2:1, 2:2, and 2:3. (Case 34175, 37094) 

• The physical CAN bus with which a RP1210 client is associated with can be set by 

specifying the appropriate channel when the the RP1210 client connects to the PVSG. 

(Case 35455) 

• Command line interface provided to update tool. (Case 35605) 

• Configuration tool now provided by 1051646 as opposed to 1051695/1051696. 

Configuration file format is now .pvsgc. (Case 36499, 35601) 

• Combined target software and configuration packages are now supported. (Case 35601) 

https://ecd.manuscript.com/default.asp?37220
https://ecd.manuscript.com/default.asp?37976
https://ecd.manuscript.com/default.asp?37190
https://ecd.manuscript.com/default.asp?37189
https://ecd.manuscript.com/default.asp?36794
https://ecd.manuscript.com/default.asp?36811
https://ecd.manuscript.com/default.asp?36796
https://ecd.manuscript.com/default.asp?37191
https://ecd.manuscript.com/default.asp?37549
https://ecd.manuscript.com/default.asp?36509
https://ecd.manuscript.com/default.asp?36503
https://ecd.manuscript.com/default.asp?36501
https://ecd.manuscript.com/default.asp?34175
https://ecd.manuscript.com/default.asp?37094
https://ecd.manuscript.com/default.asp?35455
https://ecd.manuscript.com/default.asp?35605
https://ecd.manuscript.com/default.asp?36499
https://ecd.manuscript.com/default.asp?35601
https://ecd.manuscript.com/default.asp?35601
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• Support for CAN port pairs added to configuration tool (1051646) and embedded 

software (1051642). (Case 37108) 

 Note: as a result of the CAN port pair addition, PVSG's upgraded to embedded 

software 1051642 V0.3.18 will report a configuration error (i.e. status LED error 1:3) 

until their configuration is upgraded with configuration generated by the 

configuration tool included with 1051605 V0.3.14.14. 

8.30. 1051G02.02 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), PRO1051001R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Release 
Case 

PC Software Suite Installer 1051605 0.2.9.9 (*) Case 35814 

Embedded Software Deployment 
Package 

1051642 0.2.16 Case 35798 

Configuration Tool (Executable) 1051695 2.0.0.0 Case 33864 

Configuration Spreadsheet (Excel 
Template) 

1051696 1.0.3.2 Case 35521 

* NOTE: Prior to upgrading 1051605, it is important that any old installations of 1051605 are 

removed by navigating to Control Panel > Programs and Features, selecting Parker 

Vehicle System Gateway Drivers and selecting Uninstall. 

Summary of changes from 1051G02.01: 

• Update Tool available. (Case 35603) 

• J1939 Software Identification (SOFT) and Component Identification (CI) messages 

supported. (Case 33149) 

• Preliminary ignition control added (wake on GPIO1 or GPIO2). (Case 34753) 

• Able to recover from unsuccessful configuration programming. (Case 34973) 

• Unsupported bit rate removed from configuration spreadsheet (125 kbps option removed 

from 1051696). (Case 35516) 

8.31. 1051G02.01 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), PRO1051001R00 with the following software: 

Software 
Part 
Number 

Software 
Version 

Release 
Case 

PC Software Suite Installer 1051605 0.0.0.7 Case 35046 

Embedded Software Deployment 
Package 

1051642 0.1.14 Case 35046 

Configuration Tool (Executable) 1051695 2.0.0.0 Case 33864 

Configuration Spreadsheet (Excel 
Template) 

1051696 1.0.3.1 Case 34357 

https://ecd.manuscript.com/default.asp?37108
https://ecd.manuscript.com/default.asp?35814
https://ecd.manuscript.com/default.asp?35798
https://ecd.manuscript.com/default.asp?33864
https://ecd.manuscript.com/default.asp?35521
https://ecd.manuscript.com/default.asp?35603
https://ecd.manuscript.com/default.asp?33149
https://ecd.manuscript.com/default.asp?34753
https://ecd.manuscript.com/default.asp?34973
https://ecd.manuscript.com/default.asp?35516
https://ecd.manuscript.com/default.asp?35046
https://ecd.manuscript.com/default.asp?35046
https://ecd.manuscript.com/default.asp?33864
https://ecd.manuscript.com/default.asp?34357
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Summary of software changes from 1051G02.00: 

• Supports intended operating voltage range for PVSG. (Case 35024, 34719) 

 Note: as a result of this change, the PVSG requires Power (J1-10) to be greater than 

8V in order for it to wakeup and after wakeup greater than 6V to continue operating. 

Previously it required greater than 11V to wakeup and greater than 9V to continue 

operating. 

• Status LED improvements. (Case 35076, 34743) 

8.32. 1051G02.00 
This revision provided information supporting use of the Parker Vehicle System Gateway 

(PVSG), PRO1051001R00 with the following software: 

Software Part Number Version Release Case 

PC Software Suite Installer 1051605 0.0.0.6 Case 33629 

Embedded Software Deployment Package 1051642 0.0.10 Case 33629 

Configuration Tool (Executable) 1051695 2.0.0.0 Case 33864 

Configuration Spreadsheet (Excel Template) 1051696 1.0.3.1 Case 34357 

Initial release. 

https://ecd.manuscript.com/default.asp?35024
https://ecd.manuscript.com/default.asp?34719
https://ecd.manuscript.com/default.asp?35076
https://ecd.manuscript.com/default.asp?34743
https://ecd.manuscript.com/default.asp?33629
https://ecd.manuscript.com/default.asp?33629
https://ecd.manuscript.com/default.asp?33864
https://ecd.manuscript.com/default.asp?34357
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9. GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

9.1. Preamble 
The licenses for most software are designed to take away your freedom to share and change 

it. By contrast, the GNU General Public License is intended to guarantee your freedom to 

share and change free software--to make sure the software is free for all its users. This 

General Public License applies to most of the Free Software Foundation's software and to any 

other program whose authors commit to using it. (Some other Free Software Foundation 

software is covered by the GNU Lesser General Public License instead.) You can apply it to 

your programs, too. 

When we speak of free software, we are referring to freedom, not price. Our General Public 

Licenses are designed to make sure that you have the freedom to distribute copies of free 

software (and charge for this service if you wish), that you receive source code or can get it if 

you want it, that you can change the software or use pieces of it in new free programs; and 

that you know you can do these things. 

To protect your rights, we need to make restrictions that forbid anyone to deny you these 

rights or to ask you to surrender the rights. These restrictions translate to certain 

responsibilities for you if you distribute copies of the software, or if you modify it. 

For example, if you distribute copies of such a program, whether gratis or for a fee, you must 

give the recipients all the rights that you have. You must make sure that they, too, receive or 

can get the source code. And you must show them these terms so they know their rights. 

We protect your rights with two steps: (1) copyright the software, and (2) offer you this 

license which gives you legal permission to copy, distribute and/or modify the software. 

Also, for each author's protection and ours, we want to make certain that everyone 

understands that there is no warranty for this free software. If the software is modified by 

someone else and passed on, we want its recipients to know that what they have is not the 

original, so that any problems introduced by others will not reflect on the original authors' 

reputations. 

Finally, any free program is threatened constantly by software patents. We wish to avoid the 

danger that redistributors of a free program will individually obtain patent licenses, in effect 

making the program proprietary. To prevent this, we have made it clear that any patent must 

be licensed for everyone's free use or not licensed at all. 

The precise terms and conditions for copying, distribution and modification follow. 
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9.2. TERMS AND CONDITIONS FOR COPYING, 
DISTRIBUTION AND MODIFICATION 

0. This License applies to any program or other work which contains a notice placed by the 

copyright holder saying it may be distributed under the terms of this General Public License. 

The "Program", below, refers to any such program or work, and a "work based on the 

Program" means either the Program or any derivative work under copyright law: that is to 

say, a work containing the Program or a portion of it, either verbatim or with modifications 

and/or translated into another language. (Hereinafter, translation is included without 

limitation in the term "modification".) Each licensee is addressed as "you". 

Activities other than copying, distribution and modification are not covered by this License; 

they are outside its scope. The act of running the Program is not restricted, and the output 

from the Program is covered only if its contents constitute a work based on the Program 

(independent of having been made by running the Program). Whether that is true depends on 

what the Program does. 

1. You may copy and distribute verbatim copies of the Program's source code as you receive 

it, in any medium, provided that you conspicuously and appropriately publish on each copy 

an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that 

refer to this License and to the absence of any warranty; and give any other recipients of the 

Program a copy of this License along with the Program. 

You may charge a fee for the physical act of transferring a copy, and you may at your option 

offer warranty protection in exchange for a fee. 

2. You may modify your copy or copies of the Program or any portion of it, thus forming a 

work based on the Program, and copy and distribute such modifications or work under the 

terms of Section 1 above, provided that you also meet all of these conditions: 

a) You must cause the modified files to carry prominent notices stating that you changed the 

files and the date of any change. 

b) You must cause any work that you distribute or publish, that in whole or in part contains or 

is derived from the Program or any part thereof, to be licensed as a whole at no charge to all 

third parties under the terms of this License. 

c) If the modified program normally reads commands interactively when run, you must cause 

it, when started running for such interactive use in the most ordinary way, to print or display 

an announcement including an appropriate copyright notice and a notice that there is no 

warranty (or else, saying that you provide a warranty) and that users may redistribute the 

program under these conditions, and telling the user how to view a copy of this License. 

(Exception: if the Program itself is interactive but does not normally print such an 

announcement, your work based on the Program is not required to print an announcement.) 

These requirements apply to the modified work as a whole. If identifiable sections of that 

work are not derived from the Program, and can be reasonably considered independent and 

separate works in themselves, then this License, and its terms, do not apply to those sections 

when you distribute them as separate works. But when you distribute the same sections as 

part of a whole which is a work based on the Program, the distribution of the whole must be 

on the terms of this License, whose permissions for other licensees extend to the entire whole, 

and thus to each and every part regardless of who wrote it. 
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Thus, it is not the intent of this section to claim rights or contest your rights to work written 

entirely by you; rather, the intent is to exercise the right to control the distribution of 

derivative or collective works based on the Program. 

In addition, mere aggregation of another work not based on the Program with the Program (or 

with a work based on the Program) on a volume of a storage or distribution medium does not 

bring the other work under the scope of this License. 

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object 

code or executable form under the terms of Sections 1 and 2 above provided that you also do 

one of the following: 

a) Accompany it with the complete corresponding machine-readable source code, which must 

be distributed under the terms of Sections 1 and 2 above on a medium customarily used for 

software interchange; or, 

b) Accompany it with a written offer, valid for at least three years, to give any third party, for 

a charge no more than your cost of physically performing source distribution, a complete 

machine-readable copy of the corresponding source code, to be distributed under the terms of 

Sections 1 and 2 above on a medium customarily used for software interchange; or, 

c) Accompany it with the information you received as to the offer to distribute corresponding 

source code. (This alternative is allowed only for noncommercial distribution and only if you 

received the program in object code or executable form with such an offer, in accord with 

Subsection b above.) 

The source code for a work means the preferred form of the work for making modifications 

to it. For an executable work, complete source code means all the source code for all modules 

it contains, plus any associated interface definition files, plus the scripts used to control 

compilation and installation of the executable. However, as a special exception, the source 

code distributed need not include anything that is normally distributed (in either source or 

binary form) with the major components (compiler, kernel, and so on) of the operating 

system on which the executable runs, unless that component itself accompanies the 

executable. 

If distribution of executable or object code is made by offering access to copy from a 

designated place, then offering equivalent access to copy the source code from the same place 

counts as distribution of the source code, even though third parties are not compelled to copy 

the source along with the object code. 

4. You may not copy, modify, sublicense, or distribute the Program except as expressly 

provided under this License. Any attempt otherwise to copy, modify, sublicense or distribute 

the Program is void, and will automatically terminate your rights under this License. 

However, parties who have received copies, or rights, from you under this License will not 

have their licenses terminated so long as such parties remain in full compliance. 

5. You are not required to accept this License, since you have not signed it. However, nothing 

else grants you permission to modify or distribute the Program or its derivative works. These 

actions are prohibited by law if you do not accept this License. Therefore, by modifying or 

distributing the Program (or any work based on the Program), you indicate your acceptance 

of this License to do so, and all its terms and conditions for copying, distributing or 

modifying the Program or works based on it. 

6. Each time you redistribute the Program (or any work based on the Program), the recipient 

automatically receives a license from the original licensor to copy, distribute or modify the 

Program subject to these terms and conditions. You may not impose any further restrictions 
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on the recipients' exercise of the rights granted herein. You are not responsible for enforcing 

compliance by third parties to this License. 

7. If, as a consequence of a court judgment or allegation of patent infringement or for any 

other reason (not limited to patent issues), conditions are imposed on you (whether by court 

order, agreement or otherwise) that contradict the conditions of this License, they do not 

excuse you from the conditions of this License. If you cannot distribute so as to satisfy 

simultaneously your obligations under this License and any other pertinent obligations, then 

as a consequence you may not distribute the Program at all. For example, if a patent license 

would not permit royalty-free redistribution of the Program by all those who receive copies 

directly or indirectly through you, then the only way you could satisfy both it and this License 

would be to refrain entirely from distribution of the Program. 

If any portion of this section is held invalid or unenforceable under any particular 

circumstance, the balance of the section is intended to apply and the section as a whole is 

intended to apply in other circumstances. 

It is not the purpose of this section to induce you to infringe any patents or other property 

right claims or to contest validity of any such claims; this section has the sole purpose of 

protecting the integrity of the free software distribution system, which is implemented by 

public license practices. Many people have made generous contributions to the wide range of 

software distributed through that system in reliance on consistent application of that system; 

it is up to the author/donor to decide if he or she is willing to distribute software through any 

other system and a licensee cannot impose that choice. 

This section is intended to make thoroughly clear what is believed to be a consequence of the 

rest of this License. 

8. If the distribution and/or use of the Program is restricted in certain countries either by 

patents or by copyrighted interfaces, the original copyright holder who places the Program 

under this License may add an explicit geographical distribution limitation excluding those 

countries, so that distribution is permitted only in or among countries not thus excluded. In 

such case, this License incorporates the limitation as if written in the body of this License. 

9. The Free Software Foundation may publish revised and/or new versions of the General 

Public License from time to time. Such new versions will be similar in spirit to the present 

version, but may differ in detail to address new problems or concerns. 

Each version is given a distinguishing version number. If the Program specifies a version 

number of this License which applies to it and "any later version", you have the option of 

following the terms and conditions either of that version or of any later version published by 

the Free Software Foundation. If the Program does not specify a version number of this 

License, you may choose any version ever published by the Free Software Foundation. 

10. If you wish to incorporate parts of the Program into other free programs whose 

distribution conditions are different, write to the author to ask for permission. For software 

which is copyrighted by the Free Software Foundation, write to the Free Software 

Foundation; we sometimes make exceptions for this. Our decision will be guided by the two 

goals of preserving the free status of all derivatives of our free software and of promoting the 

sharing and reuse of software generally. 

NO WARRANTY 

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 

WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE 

LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT 
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HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT 

WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT 

NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 

FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY 

AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM 

PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 

REPAIR OR CORRECTION. 

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 

WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 

MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE 

LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 

INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 

INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF 

DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 

YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH 

ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 

ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

9.3. END OF TERMS AND CONDITIONS 


